# COMOS 10.1.3.0.0 - Readme

## Security information

## Directives, Norms and Standards in COMOS

## Web links

## Secure Network Communication

## Software requirements

## Hardware requirements

## Prepare network login

## Installing COMOS and additional software

## Discontinuations and functional boundaries

## Known Issues

## Changes following deadline
Legal information

Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are graded according to the degree of danger.

**DANGER**
indicates that death or severe personal injury will result if proper precautions are not taken.

**WARNING**
indicates that death or severe personal injury may result if proper precautions are not taken.

**CAUTION**
indicates that minor personal injury can result if proper precautions are not taken.

**NOTICE**
indicates that property damage can result if proper precautions are not taken.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property damage.

Qualified Personnel

The product/system described in this documentation may be operated only by personnel qualified for the specific task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified personnel are those who, based on their training and experience, are capable of identifying risks and avoiding potential hazards when working with these products/systems.

Proper use of Siemens products

Note the following:

**WARNING**
Siemens products may only be used for the applications described in the catalog and in the relevant technical documentation. If products and components from other manufacturers are used, these must be recommended or approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and maintenance are required to ensure that the products operate safely and without any problems. The permissible ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks

All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the information in this publication is reviewed regularly and any necessary corrections are included in subsequent editions.
# Table of contents

1. Security information ................................................................. 9
2. Directives, Norms and Standards in COMOS ............................................. 11
3. Web links .................................................................................. 13
4. Secure Network Communication ..................................................... 15
5. Software requirements ................................................................. 17
   5.1 COMOS client (local installation) ............................................... 17
   5.2 Notes on a 64-bit operating system ........................................... 17
   5.3 Citrix ................................................................................... 18
   5.4 Approved third-party software .................................................. 19
   5.5 PDF .................................................................................. 19
   5.6 Acrobat Reader X ................................................................. 19
   5.7 Virtualization ....................................................................... 19
   5.8 File server ........................................................................ 20
   5.9 Enterprise Server ................................................................ 20
   5.10 COMOS LS ........................................................................ 20
   5.11 Freely configurable revision printer ........................................ 20
   5.12 Shipped internally used third-party software ............................ 21
   5.13 Software requirements for COMOS Mobile Solutions .............. 21
   5.14 Recommended versions of the database server ........................... 21
6. Hardware requirements .................................................................. 23
   6.1 Network connection ................................................................. 23
   6.2 Virtualization ....................................................................... 23
   6.3 Information for RAID systems .................................................. 24
   6.4 Overview of the requirements for cooperation ............................ 24
   6.5 Setting up network segments/Cache Validation Service (CVS) ...... 25
      6.5.1 Overview/Multicast technique for CVS ............................... 25
      6.5.2 Network segments / CVS testing ....................................... 26
      6.5.3 Controlling CVS in the registry ......................................... 26
      6.5.4 Error case .................................................................... 27
      6.5.5 Interaction with other programs ....................................... 28
      6.5.6 Kernel functions for CVS ................................................ 28
   6.6 Setting up SBM ..................................................................... 29
      6.6.1 Overview of SBM ............................................................ 29
      6.6.2 Setting up SBM ............................................................... 29
# Table of contents

## 6.7 Combining several databases using merge replication
- 6.7.1 Example for a server landscape: 30
- 6.7.2 Work instruction when using replication: 31
- 6.7.3 Setting up the servers: 31
- 6.7.3.1 Release for the snapshots: 31
- 6.7.3.2 Setting up the distributor: 31
- 6.7.3.3 Setting up the publisher: 33
- 6.7.3.4 Setting up subscriptions: 35
- 6.7.4 Alternative setup of the replication with TSQL scripts: 38
- 6.7.4.1 Requirement for the use of TSQL scripts: 38
- 6.7.4.2 Setting up the distributor: 38
- 6.7.4.3 Setting up the publisher: 39
- 6.7.4.4 Alternative setup of the subscriber with TSQL script: 43

## 6.8 Infrastructure requirements for clients
- 6.8.1 Standard clients: 44
- 6.8.2 Citrix clients: 45

## 6.9 Infrastructure requirements for servers
- 6.9.1 Database server prerequisites: 46
- 6.9.2 File server: 47
- 6.9.3 Licence server: 48
- 6.9.4 COMOS Web: 48
- 6.9.5 COMOS Enterprise Server: 49
- 6.9.6 Citrix server: 50

## 7 Prepare network login
- 7.1 Definition of the three types of logins for COMOS users: 51
- 7.2 Database server login using DAT password file: 52
- 7.3 Configuration of the operating system: 52
- 7.4 Securing network access with network login: 53
- 7.4.1 Aim of the network login: 53
- 7.4.2 Overview of the network login sequence: 54
- 7.4.3 Protected login names: 55
- 7.4.4 COMOS rights relating to network login: 55
- 7.4.5 Calling up the Network Security Configuration Tool: 56
- 7.4.6 Distributing a DAT file: 56
- 7.4.7 Reestablishing access to connected network drives: 57
- 7.5 Programming extensions for network login: 58
  - 7.5.1 Class IComosDAutoNetworkLogin: 58
  - 7.5.2 Class IComosDWorkset: 59
  - 7.5.3 Interaction between network login and XStdMod.Dll: 59
  - 7.5.4 Interaction between network login and COMOS.dll: 60

## 8 Installing COMOS and additional software
- 8.1 Important note for Windows 7 and Windows Server: 61
- 8.2 Terminal Server: CLS Remote License Service: 62
- 8.3 Installing COMOS with 4 GB support: 62
- 8.4 Installing COMOS on Citrix: 63
### Table of contents

8.4.1 Third party licenses of a Citrix environment .......................................................... 63
8.4.2 COMOS licenses for a Citrix environment.............................................................. 63
8.4.3 Installation overview for Citrix ............................................................................. 64
8.4.4 Printers in Citrix environments .............................................................................. 64
8.4.5 Installing COMOS on the Citrix server ................................................................. 65
8.4.5.1 Start the installation on Citrix ........................................................................... 65
8.4.5.2 Citrix Delivery Services Console ..................................................................... 65
8.4.5.3 Novell Networks .............................................................................................. 65
8.4.6 Configuring a Citrix ICA Client ............................................................................ 66
8.4.6.1 COMOS ICA Client......................................................................................... 66
8.4.6.2 Different access modes on Citrix servers ........................................................ 66
8.4.6.3 Server settings ............................................................................................... 66
8.4.6.4 ICA connection to COMOS ............................................................................. 66
8.4.6.5 Client settings ............................................................................................... 67
8.4.6.6 Windows Server operating systems ................................................................. 69
8.4.7 DBMon Outputs .................................................................................................... 69
8.4.8 FAQs ..................................................................................................................... 69
8.5 Installing COMOS with the Setup browser ............................................................... 71
8.5.1 Software requirements ......................................................................................... 71
8.5.2 COMOS Setup browser: Start window ................................................................. 71
8.5.3 Installing the COMOS portfolio .......................................................................... 73
8.5.4 Installing COMOS ............................................................................................... 74
8.5.4.1 Welcome screen from the InstallShield Wizard ............................................... 74
8.5.4.2 Conditions of the license instructions .............................................................. 74
8.5.4.3 Target folder for the InstallShield Wizard ....................................................... 74
8.5.4.4 Select the source folder for the service pack .................................................. 75
8.5.4.5 Defining the licensing ..................................................................................... 75
8.5.4.6 Starting and completing the installation .......................................................... 76
8.5.4.7 Covered part modules .................................................................................... 76
8.5.4.8 Changes on the PC ......................................................................................... 76
8.5.4.9 Customization ................................................................................................. 77
8.5.5 Uninstalling COMOS ........................................................................................... 79
8.5.6 Installing the COMOS database .......................................................................... 79
8.5.7 Installing COMOS license products .................................................................... 80
8.5.7.1 Overview of COMOS License Management .................................................. 80
8.5.7.2 Installing COMOS LS ...................................................................................... 82
8.5.7.3 Installing the COMOS Remote License Supplier ........................................... 82
8.5.7.4 Installing the COMOS License User Manager ............................................... 82
8.5.8 Installing COMOS add-on programs .................................................................. 83
8.5.8.1 Overview of the COMOS add-on programs ..................................................... 83
8.5.8.2 "COMOS DocumentView” ............................................................................. 84
8.5.8.3 TIFF-printer limitation ................................................................................... 84
8.5.8.4 Installing the "COMOS TIFF Printer” ............................................................. 84
8.5.8.5 Installing "COMOS TIFF server” ................................................................... 87
8.5.8.6 "Teamcenter FCC” ......................................................................................... 88
8.5.8.7 Installing the COMOS revision printer (HARP) ............................................. 89
8.5.8.8 "SIMATIC XML Transfer” .............................................................................. 89
8.5.9 Installing third-party programs ............................................................................ 89
8.5.9.1 Overview of the COMOS third party programs .............................................. 89
8.5.9.2 Install Adobe Reader ...................................................................................... 90
8.5.9.3 Install pdffFactory Pro ................................................................................... 90
8.5.9.4 Installing the dongle driver ............................................................................ 91
Table of contents

8.5.10 Installing COMOS documentation................................................................. 91
8.5.10.1 Overview of the COMOS documentation.................................................. 91
8.5.10.2 "What's New?".......................................................................................... 92
8.5.10.3 "Readme with installation instructions"..................................................... 92
8.5.10.4 Known Issues............................................................................................ 92
8.5.10.5 "Frequently Asked Questions".................................................................... 93
8.6 Installing COMOS updates.................................................................................. 93
8.6.1 Overview......................................................................................................... 93
8.6.2 Call options..................................................................................................... 93
8.6.3 Installation........................................................................................................ 94
8.6.4 System Environment/Further Conditions....................................................... 94
8.6.5 "ServicePack.xml"......................................................................................... 94
8.6.6 Specifying the update path manually using the dialog window....................... 94
8.6.7 Parameter-controlled update in Silent mode / Console mode.......................... 95
8.6.8 Installing subversions...................................................................................... 96
8.7 Parameter-aided installation of COMOS............................................................ 97
8.7.1 General........................................................................................................... 97
8.7.2 "Setup.exe parameter.txt"............................................................................... 97
8.7.2.1 Command line parameters for "Setup.exe".................................................. 97
8.7.2.2 Passing parameters to the .msi file incorporated in "Setup.exe"..................... 98
8.7.2.3 Running "Setup.exe" in Silent mode.............................................................. 98
8.7.2.4 Specifying the setup language from the command line.............................. 99
8.7.2.5 Disadvantages of using the "/v" parameter................................................... 99
8.7.2.6 Using the parameter "/l"............................................................................... 99
8.7.2.7 Stating a password from the command line............................................... 99
8.7.2.8 Stating the installation mode from the command line................................. 100
8.7.2.9 Administration............................................................................................ 100
8.7.2.10 Advertise.................................................................................................... 100
8.7.2.11 Uninstallation............................................................................................ 100
8.7.2.12 Repair........................................................................................................ 100
8.7.2.13 Wait............................................................................................................ 100
8.7.3 "MSIDatenbank_Parameter.txt"...................................................................... 101
8.7.4 Installation in silent mode.............................................................................. 104
8.8 Carrying out a version change......................................................................... 104
8.8.1 Definitions...................................................................................................... 104
8.8.2 Testing new version....................................................................................... 105
8.8.2.1 Test............................................................................................................. 105
8.8.2.2 Testing new version.................................................................................... 105
8.8.2.3 Create a copy of the database..................................................................... 105
8.8.2.4 Installing a new COMOS client................................................................... 105
8.8.2.5 Adjusting the COMOS index and the database scheme............................. 106
8.8.2.6 Increasing the document version............................................................... 106
8.8.2.7 Increasing the database version................................................................. 106
8.8.3 Changing the version.................................................................................... 107
8.9 Errors and special settings.............................................................................. 107
8.9.1 Permissible screen resolutions....................................................................... 107
8.9.2 Interrupted communication........................................................................... 108
8.9.3 TIFF printer................................................................................................... 108
8.9.4 Resource problems while printing................................................................. 108
## Discontinuations and functional boundaries

10.1 COMOS help system

10.2 Incorrect installation under Windows 7 Enterprise and Server 2012

10.3 COMOS License Management

10.4 Administration: PDF export with PDFLib

10.5 Administration: Subsequent changing of project properties in connection with consolidation layers

10.6 Administration: Adding documents to a task

10.7 Administration: Service for full-text search

10.8 Administration: Copying the base project

10.9 Administration: Attributes with fixed format length

10.10 Administration: Merging objects in the cDB

10.11 Administration: Performance with SBM

10.12 ElementName Z

10.13 Troubleshooting during excessive GDI resource consumption with COMOS

10.14 Interfaces: PDI interface

10.15 Incompatibilities when changing from "PDMS PipeSpec Interface" to "COMOS PipeSpec Interface (PDMS)"

10.16 Interfaces: CDI

10.17 Interfaces to MS Project and Primavera

10.18 Report templates dependent on working layers

10.19 "Revision" file name prohibited

10.20 Add-ins are not displayed

10.21 Report: Insert OLE object

10.22 P&ID: Project properties for pipe spec mapping

10.23 Inspection: Calibration of measuring devices

10.24 Shutdown

10.25 MRO: System-relevant tab

10.26 Word export

10.27 Integrated Engineering

## Known Issues

10.1 COMOS help system

10.2 Incorrect installation under Windows 7 Enterprise and Server 2012

10.3 COMOS License Management

10.4 Administration: PDF export with PDFLib

10.5 Administration: Subsequent changing of project properties in connection with consolidation layers

10.6 Administration: Adding documents to a task

10.7 Administration: Service for full-text search

10.8 Administration: Copying the base project

10.9 Administration: Attributes with fixed format length

10.10 Administration: Merging objects in the cDB

10.11 Administration: Performance with SBM

10.12 ElementName Z

10.13 Troubleshooting during excessive GDI resource consumption with COMOS

10.14 Interfaces: PDI interface

10.15 Incompatibilities when changing from "PDMS PipeSpec Interface" to "COMOS PipeSpec Interface (PDMS)"

10.16 Interfaces: CDI

10.17 Interfaces to MS Project and Primavera

10.18 Report templates dependent on working layers

10.19 "Revision" file name prohibited

10.20 Add-ins are not displayed

10.21 Report: Insert OLE object

10.22 P&ID: Project properties for pipe spec mapping

10.23 Inspection: Calibration of measuring devices

10.24 Shutdown

10.25 MRO: System-relevant tab

10.26 Word export

10.27 Integrated Engineering

## Changes following deadline

11.1 Introduction

11.2 COMOS Platform

11.2.1 Platform Administration

11.3 COMOS Automation
Siemens provides products and solutions with industrial security functions that support the secure operation of plants, solutions, machines, equipment and/or networks. They are important components in a holistic industrial security concept. With this in mind, Siemens' products and solutions undergo continuous development. Siemens recommends strongly that you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable preventive action (e.g. cell protection concept) and integrate each component into a holistic, state-of-the-art industrial security concept. Third-party products that may be in use should also be considered. For more information about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-specific newsletter. For more information, visit http://support.automation.siemens.com.
Directives, Norms and Standards in COMOS

All references to directives, norms and standards in the software interface and the documentation serve as guides. SIEMENS AG claims no conformity of COMOS to these directives, norms and standards. Rather, we draw attention to the fact that COMOS supports work in accordance with the norms and standards listed below. With appropriate adaption, COMOS applications can be complemented with other norms and standards beyond this list (example: 21 CFR Part 11).

<table>
<thead>
<tr>
<th>Standards</th>
<th>Products</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASME Y14</td>
<td>Platform</td>
</tr>
<tr>
<td>DIN 1219</td>
<td>EI&amp;C</td>
</tr>
<tr>
<td>DIN 19227-1:1993</td>
<td>EI&amp;C, P&amp;ID</td>
</tr>
<tr>
<td>DIN 2481:1979</td>
<td>P&amp;ID</td>
</tr>
<tr>
<td>DIN 61082</td>
<td>Platform</td>
</tr>
<tr>
<td>DIN 6771</td>
<td>Platform</td>
</tr>
<tr>
<td>DIN EN IEC 61355</td>
<td>Platform</td>
</tr>
<tr>
<td>DIN EN ISO 7200</td>
<td>Platform</td>
</tr>
<tr>
<td>EN ISO 10628-2:2000</td>
<td>FEED, P&amp;ID</td>
</tr>
<tr>
<td>IEC 60617</td>
<td>EI&amp;C</td>
</tr>
<tr>
<td>IEC 61131-3</td>
<td>Logical</td>
</tr>
<tr>
<td>IEC 62424:2008</td>
<td>P&amp;ID</td>
</tr>
<tr>
<td>DIN EN 62424</td>
<td></td>
</tr>
<tr>
<td>BS EN 62424</td>
<td></td>
</tr>
<tr>
<td>IEC/PAS 62424</td>
<td></td>
</tr>
<tr>
<td>ISO 216 (DIN 476 Replacement)</td>
<td>Platform</td>
</tr>
<tr>
<td>ISO 3511-3</td>
<td>EI&amp;C</td>
</tr>
<tr>
<td>ISO/TS 81346-3:2012</td>
<td>P&amp;ID, EI&amp;C</td>
</tr>
<tr>
<td>VDE 0293</td>
<td>EI&amp;C</td>
</tr>
<tr>
<td>VDE 0293-308</td>
<td>EI&amp;C</td>
</tr>
<tr>
<td>VDE 0813</td>
<td>EI&amp;C</td>
</tr>
</tbody>
</table>
Web links

Note
Please read through the readme carefully, as it contains important information and additions for COMOS. The statements in this readme file take priority over the COMOS manuals.

- Further information on COMOS is available on the Internet on the COMOS website (www.siemens.com/comos).
- Contact persons for COMOS software solutions in sales and service can be found online at COMOS contact person (www.automation.siemens.com/mcms/plant-engineering-software/en/contact/).
- You can find free electronic documentation on the Internet at COMOS documentation (www.siemens.com/comos-manuals).
- You can find the installation instructions for the documentation supplied with COMOS here: Installing COMOS documentation (Page 91)
Secure Network Communication

Protocols for network communication

By default, COMOS uses the multicast method for LAN communication. If you want to increase network security even further, you can use the "SBM" method instead. See also section Setting up SBM (Page 29).

When you use SBM, even distributed database servers can be synchronized by means of merge replication. See section Combining several databases using merge replication (Page 30).

SBM and the merge replication are only supported for Microsoft SQL server.
Software requirements

5.1 COMOS client (local installation)

The following are supported:

- Windows XP SP3 (32-bit)
- Windows 7 SP1
- Windows Server 2012 R2
- For all operating systems:
  - .NET Framework 3.5 SP1 (for Windows 7 SP1: integrated in the operating system)
  - .NET Framework 4
  - Microsoft Visual C++ 2010 Redistributable Package (x86)

If the .NET Framework 4 and Microsoft Visual C++ 2010 are missing they are automatically installed during the installation. Follow the installation instructions. The procedure may take up to half an hour.

Installations

The HTML user interface of the COMOS Setup browser is not useful because of restrictive security settings on Windows 7 (32-bit and 64-bit) and later as well as Windows Server 2008 R2 and later. Start all product installations by right-clicking the setup file and selecting the option "Run as administrator". See also chapter Important note for Windows 7 and Windows Server (Page 61).

5.2 Notes on a 64-bit operating system

Standard import in Windows 7

The registry entry HKLM\Software\Wow6432Node\Microsoft\Jet\4.0\Engines\Text is accessed for clients with a 64-bit operating system.

- The default value is "CSVDelimited", which means that the individual values are separated by a comma.
- If you want to use the standard import in Windows 7, set the value to "Delimited(;)". "Delimited(;)" is set as the default value for clients with a 32-bit operating system.
Setting up a ODBC connection

A 32-bit ODBC connection must be visibly present for COMOS on 64-bit operating systems. You set it with the following program:
c:\windows\syswow64\odbcad32.exe

5.3 Citrix

Configuration options

Different configurations are possible:

- Configuration 1
  - Citrix Presentation Server 4.5 Rollup 6
  - OS: Windows Server 2003 R2
  - MS Patch KB955692
  - Microsoft WIC components may be required.

- Configuration 2
  - Citrix Xenapp 6.0
  - OS: Windows Server 2008 R2
  - Xenapp 6.0 Rollup 2 is required for Windows Server 2008 R2 SP1.

- Configuration 3
  - Citrix Xenapp 6.5
  - OS: Windows Server 2008 R2 SP1

- Configuration 4
  - Citrix Xenapp 7.6
  - OS: Windows Server 2012 R2
  - Optional: Office 2010

Note

Tiff printer

The Tiff printer TiffTerm70 cannot be used as of Windows Server 2008 R2.

Recommendation

There are no known dependencies with the Citrix client used. Use the Citrix client that is recommended by Citrix for the Citrix version used.
5.4 Approved third-party software

Microsoft Office

- Office 2003
- Office 2007
- Office 2010

Other software

- AutoVue 19.2
- Pro II 7.x - 8.1 (document type)

5.5 PDF

To read PDF files, you need a PDF Reader which is compatible with PDF 1.7 (ISO32000-1:2008 PDF).

Adobe Reader 11 is supported.

You can find additional information on this topic in the "COMOS Platform Administration" manual, keyword "General information on Adobe PDF".

5.6 Acrobat Reader X

Old full text search under Adobe Reader X

To allow the full text search of the documentation of a version prior to 10.0 under Adobe Reader X, the file path of the documentation package must not contain a blank space.

5.7 Virtualization

VMware

- VMware Workstation 6
- VMware Workstation 6.5
- VMware Workstation 7 (recommended)
5.8 File server

Requirements

Make sure that the file server for SMB2.0 (active directory Windows 2000 and later) is compatible and allows access to small files with low latency times. No fault tolerance exists in COMOS for accessing files.

See also section Hardware requirements (Page 23).

5.9 Enterprise Server

The Enterprise Server for COMOS 10.x supports the same operating systems as COMOS 10.x.

5.10 COMOS LS

Supported operating systems

- Windows XP SP3
- Windows 7
- Windows Server 2008 R2
- Windows Server 2012

Additional information on this topic can be found in the "COMOS Platform Administration" manual under the keyword "Managing licenses with COMOS LS".

5.11 Freely configurable revision printer

The freely configurable revision printer (HARP) requires one of the following versions of Ghostscript:

- GhostScript 9.05 – 32-bit
- GhostScript 9.05 – 64-bit

The freely configurable revision printer (HARP) requires one of the following operating systems:

- Windows XP SP3
- Windows 7
- Windows Server 2008 R2
- Windows Server 2012

Additional information on this topic can be found in the "COMOS Platform Administration" manual under the keyword "Revision archive "Configuring freely configurable revision printer"."
5.12 **Shipped internally used third-party software**

Windows Installer

COMOS 9.0 and later: 3.1 for Windows 2000 SP3 systems and later

Script environment

VBScript.dll: 5.6 or 5.7

VBScript.dll is part of the "Microsoft Script" package and is preinstalled correctly on Windows XP SP3 systems and later.

On other systems, the components are installed through the Internet Explorer.

5.13 **Software requirements for COMOS Mobile Solutions**

Requirements for COMOS Mobile Solutions

COMOS Mobile Solutions is a collection of different solutions. Each of these solutions has different software requirements.

You can find more information on this topic in the "COMOS Mobile Solutions" manual, keyword "Software requirements for COMOS Mobile Solutions".

See also

[COMOS client (local installation)](Page 17)


5.14 **Recommended versions of the database server**

Overview

- Microsoft SQL Server 2008
  Tested on Windows Server 2008 SP1 (64-bit)
- Microsoft SQL Server 2008 R2
  Tested on Windows Server 2008 R2 SP1
- Microsoft SQL Server 2012 SP1
  Tested on Windows server 2012
- Microsoft SQL Server 2014
  Tested on Windows Server 2012 R2
Software requirements

5.14 Recommended versions of the database server

- Oracle, Release 10.g
  Tested on Windows 10GR2 Server 2003 SP1 (64-bit). An Oracle 10 client on Windows XP (32-bit) was used on the counter side.

- Oracle Release 11G R1
  Tested on Windows Server 2008 SP1 (64-bit). A client on XP SP3 (32-bit) was used on the opposite side.

- Oracle Release 11G R2

- Oracle Release 12
6 Hardware requirements

6.1 Network connection

Latency period

COMOS clients should be operated with a 100 Mbit network connection. IPV6 is not supported.

Citrix clients require approx. 1 Mbit network capacity and a latency period of less than 50 ms. The latency period depends on the number of network components and the distance to the server.

Make sure that the latency period remains constant. Certain network accesses, for example, through mobile data connections, increase the latency period by approximately 100 ms so that some COMOS features become inert. Satellite connections are not recommended for Citrix operation since the latency periods hardly lie below 500 ms.

The file server, database server and the Citrix server should have access to a 1 Gbit line capacity. External SAN drives or SAN devices should be connected with 4 Gbit and a separate network.

For a large number of Citrix servers, the network between the servers should be upgraded to 10 Gbit.

WAN connections are usually realized via rented network lines or company-own networks.

For the net connection, you should take into account that a signal run time of 3 ms occurs per 1000 km line length, and that a number of other delays add up due to data processing in routers or signal enhancers. Typically there is a delay of 2-5 ms per router.

Depending on the router technology used additional latency times may apply, which are a few microseconds at best and up to five milliseconds in older products.

The ICA protocol should have priority for Citrix clients and a certain bandwidth should be reserved. On average you need 100 Kbit per client, but you have to take into account peak performances of up to 1 Mbit. Should a shortage of line capacity occur you will observe a sharp increase in latency time. Likewise, the latency time will increase sharply if the corresponding client or server is overstrained with comprimizing/decomprimizing ICA protocol data. Complex graphical operations such as zooming or moving of larger drawings also produce a considerable load.

6.2 Virtualization

COMOS supports virtualization in VMware Workstation 7.

Based on the manufacturer's compatibility statements, the entire COMOS infrastructure can be executed in VMware ESX.

The license server may require a USB port, which is provided in a VMware ESX environment via the AnywhereUSB product.
The resources in ESX can be configured to a great extent. Therefore, use the calculation basis that were created for real hardware when assigning resources.

Virtual machines work with a virtualized file system. This is contained either in the local VMware Server or on an external storage solution. The file systems of several computers share one resource. Therefore, a particularly powerful solution has to be made available in this case.

1-2 Gbit transfer capacity are assumed per virtualized Citrix server. Recommendation: For a database server, make 1-4 GB transfer capacity available depending on the number of clients.

See also

Virtualization (Page 19)

6.3 Information for RAID systems

To avoid performance losses, configure the database file system in accordance with Microsoft Support document 929491. This applies to the Microsoft SQL Server and to Oracle.

See also

Hardware requirements (Page 23)

Database server prerequisites (Page 46)

6.4 Overview of the requirements for cooperation

Multiple clients can work on a shared database in COMOS. The various work states of a shared database are synchronized by means of the following alternative technologies:

- **CVS**
  
  CVS = Cache validation service
  
  With CVS, the multicast method is used instead of the pure broadcast.
  
  See chapter Setting up network segments/Cache Validation Service (CVS) (Page 25).

- **SBM**
  
  SBM = Service broker messages
  
  This method replaces the broadcast or multicast.
  
  See chapter Setting up SBM (Page 29).

- Merge replication
  
  If you are working with several databases instead of a shared database, you must also use the merge replication method. With this method, several users initially work autonomously on location-specific databases at different locations. The changes are then later merged into a uniform result.
  
  See chapter Combining several databases using merge replication (Page 30).

Merge replication is only supported in combination with SBM in COMOS.
6.5 Setting up network segments/Cache Validation Service (CVS)

6.5.1 Overview/Multicast technique for CVS

If multiple clients in networks work with a common set of data, it is necessary to ensure that all information is constantly updated on all stations. This necessary constant data exchange and the corresponding coordination is ensured in COMOS by the Cache Validation Service (CVS).

In order to keep the load on the network as low as possible, COMOS CVS works in "multicast" mode. This technique functions extremely stably, decentralized and does not require any server capacity. With the exception of setting up Multicast on the network routers, Multicast does not require administration.

In contrast to "Broadcast", Multicasting is a vendor-independent standard with a low network load. Data packages are only inserted once into the network. Only when the router knows that a workstation in this segment requires or has requested the data package, is the data package passed on to the segments.

The data packet is also sent only once within the segment and can be fetched by the workstations that require this information. In this way, the network traffic is restricted to the necessary minimum. You can find additional information on this topic at www.microsoft.com under the keyword "Multicast".

Each computer on which COMOS (version 5.3.6 or later) is installed automatically works with the COMOS Cache Validation Service (CVS). COMOS CVS uses the following addresses and protocols:

- Router communication to IP address 224.0.0.22, IGMP protocol
- Multicast IP address: 234.5.6.7 (registry key: CVSIPAddress)
- Port Address: 3456

In the registry, you can specify how many routers are permitted for the CVS:

[HKEY_LOCAL_MACHINE\SOFTWARE\INNOTEC\COMOS] "CVSTimeToLive"=dword: 00000002

The number of routers connected in series for the CVS traffic can be increased by increasing the default value of CVSTimeToLive=2.

- Value=2, then CVS is possible via 1 router (default)
- Value=3, then CVS is possible via 2 routers
- Value=n, then CVS is possible via (n-1) routers

Time sequence

All the changes are allowed to accumulate over a period of 5 seconds and are then sent in a single block. All other COMOS instances receive these messages. If the respective objects already exist in the working memory, they are updated. If an object specified in the CVS message has not actually been loaded by a COMOS instance, no changes are made.
6.5.2 Network segments / CVS testing

The following description applies to the Windows XP operating system.

Your router is multicast-capable. Communication between the server and the workstations functions if you carried out the test described below successfully across your router.

- "DBMON.EXE"
  \"<COMOS directory>\BIN\DBMON.EXE"
  Monitor for the output of COMOS CVS test output for "Comos.exe" and "ptmcast.exe".

- "ptmcast.exe"
  \"<COMOS directory>\BIN\ptmcast.exe"
  Test program to check the connection between the COMOS CVS sender and receiver (formerly: SMS), comparable to a "ping" program.

Performing the CVS test

The CVS function test is independent of a COMOS installation.

1. Start "DBMON.EXE".

2. Open two DOS windows and switch to the directory in which the "ptmcast.exe" program is located.

3. Start the CVS receiver with PTMcast /r.
   The parameter stands for "receive". This specifies that this instance of PTMcast acts as the receiver. The command is as follows with a standard installation:
   c:\COMOS\bin\>PTMcast/r
   The following line is displayed:
   Waiting for receiving until pressed Return-Key for quit

4. Start the CVS sender with PTMcast.
   The command is as follows with a standard installation:
   c:\COMOS\bin\>PTMcast
   The program PTMcast sends text to the instance declared as a receiver with /r.
   The following lines are displayed at the sender:
   PTMcast: Message <LOGO39-02\schneider: Test-Message Nr.1> with 100 Bytes sended!
   PTMcast: Message <LOGO39-02\schneider: Test-Message Nr.2> with 100 Bytes sended!
   ...

5. The following text is displayed in the receiver's DOS window:
   Waiting for receiving until pressed Return-Key for quit
   PTMcast.OnReceive: Message <LOGO50-01\mueller: Test-Message Nr.2> with 100 Bytes!
   PTMcast.OnReceive: Message <LOGO50-01\mueller: Test-Message Nr.3> with 100 Bytes!
   ...
Diagnostics

If no feedback has been given at the latest after 30 seconds, the connection between the sender and receiver is faulty. If the test messages generated by "ptmcast.exe" are transmitted with errors, a corresponding message is output in DBMon. The test message from "ptmcast.exe" can also be larger or smaller than 100 byte. The message size can be changed per parameter. The control parameters of "ptmcast.exe" can be called by: "...\ptmcast.exe ?".

6.5.3 Controlling CVS in the registry

Starting with ServicePack SP80SP715, the following applies:

In addition, the CVS is controlled by a registry entry that allows you to increase the range for the CVS (multicasting):

HKEY_LOCAL_MACHINE\Software\INNOTEC\COMOS

The DWORD entry must be as follows: CVSTimeToLive The default value is 2 so that excessive network traffic does not arise.

Example: If you set the entry to the value 5, the following message is displayed in the DBMon at a COMOS start:

Comos.CWSSocket: Setting IP Time-To-Live = 5 (4 Hop(s)) succeeded.

The CVS traffic by default runs over a maximum of one router. The range is changed by means of the above-mentioned registry entry. Valid values are all natural numbers >= 1.

- 1 = CVS only within its own segment
- 2 = CVS over max. 1 router
- 3 = CVS over max. 2 routers, etc.

The "ptmcast.exe" test program has a TTL default value of 10.

6.5.4 Error case

Possible causes:

- TCP/IP protocol is not used
- Router is not multicast-compatible
- Multicast option of a multicast-compatible router has not been activated.
  The multicast option of the router must be activated. The multicast protocol "IGMP Version 1" is supported. The complete network connection between two COMOS clients must be bidirectionally multicast-compatible, because each receiver can also be a sender at the same time.

This is not recognized and reported as an error by the system. The error has to be determined by the user by means of "ptmcast.exe".
6.5 Setting up network segments/Cache Validation Service (CVS)

Errors that are caused by the software of the WinSock connection:

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>WSAStartup failed</td>
<td>Winsockets cannot be initialized</td>
</tr>
<tr>
<td>WSASocket() failed</td>
<td>Winsockets does not respond</td>
</tr>
<tr>
<td>setsockopt() SO_REUSEADDR failed</td>
<td>WinSockets port address cannot be set</td>
</tr>
<tr>
<td>setsockopt() SO_RCVBUF failed</td>
<td>Buffer size cannot be set</td>
</tr>
<tr>
<td>WSARecvFrom() failed</td>
<td>Error when receiving a message</td>
</tr>
</tbody>
</table>

Errors that take effect on the COMOS level:

<table>
<thead>
<tr>
<th>Error</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>gethostbyname failed</td>
<td>Local computer name could not be determined</td>
</tr>
<tr>
<td>COMOS: CWSSocket::ReceiveSendLoop error</td>
<td>Error when sending or receiving a message</td>
</tr>
</tbody>
</table>

6.5.5 Interaction with other programs

CVS output: DBMon

Messages from the CVS are also visible in DBMon.

Testing CVS: "ptmcast.exe"

The "ptmcast.exe" program tests the CVS.

See also Chapter Network segments / CVS testing (Page 26).

Evaluating CVS

The CVS Monitor displays all clients that can currently be reached via the CVS and outputs various types of information regarding the clients and the CVS status.

6.5.6 Kernel functions for CVS

You find more information on this topic in the "Class Documentation COMOS_dll" manual, keyword "CVS".
6.6 Setting up SBM

6.6.1 Overview of SBM

Changes compared to CVS

SBM offers a few innovations compared to the previous version CVS:

- No longer broadcast
- Guaranteed message transmission
- Message transmission can be encrypted
- StationID from previously defined pool
- Bidirectional communication
- Transmission in sent sequence (queue)

See also Overview/Multicast technique for CVS (Page 25).

Requirement

To use the SBM method, you need:

- COMOS Version 10.0 and higher
- SQL Server 2008 R2 or higher (Oracle and Access are not supported)

Parallel operation of CVS and SBM

COMOS uses the CVS method (multicast) as standard.

SBM can be used only after you have imported the scripts for SBM.

You can also use both technologies in parallel. To do so use the server instruction "SendCVSMessagesWithOldStyle".

6.6.2 Setting up SBM

1. Unpack the file "NewCVS.zip".

2. Carry out the following command with the access data of a "sysadmin" database:

   sqlcmd -S <SERVERNAME> -U <USERNAME> -P <PASSWORD> -v DBName=<DATABASENAME> ScripDir="<\Server\Share\Folder>" -i"<\Server\Share\Folder\00-preparedb.sql>"

Replace the variables in the angular brackets with your corresponding access data, names and paths.
Combining several databases using merge replication

SBM can be applied to several databases using merge replication. With merge replication, several users initially work autonomously at different locations. The changes are then later merged into a uniform result. This chapter describes how to set up a merge replication on an MS SQL Server 2008 R2 SP1.

The use of merge replication is recommended in the following situations:

- When the same data is updated by several subscribers at different times. When changed data is forwarded to the publisher and to different subscribers.
- When subscribers need to receive data and make changes offline. When changes are synchronized with the publisher and other subscribers at a later time.
- When each subscriber needs a different data partition.
- When the application only has to access the end result of the changes. Intermediate stages are irrelevant.

Example for a server landscape

- 5 servers
  - 1 distributor
  - 1 publisher
  - 3 subscribers
- Servers are MS SQL Servers 2008 R2 SP1
- Servers are in one domain
- 3 domain users
  - Server Agent
  - Merge Agent
  - Snapshot Agent
- Servers are up-to-date and have installed all the latest updates.

Note

Number of subscriber servers

You can set up merge replication with more or fewer subscribers. You must set up the same number of subscriptions as subscriber servers. The chapters below refer to the number of servers listed above.

See also chapter Setting up a subscription (Page 36).
6.7.2 Work instruction when using replication

Each location works with a subscriber database by default. Partition your data to minimize the number of replication conflicts. To do this, create a working layer for each location on which all work is performed within the locations. All locations then work with different data records.

Release the information from the working layers centrally on the publisher to make it available to all users. The publisher has top priority and wins any conflicts which may arise with the subscribers.

Users are managed centrally via the publisher.

6.7.3 Setting up the servers

6.7.3.1 Release for the snapshots

Create a release that can be accessed by all servers.

The snapshots of the publisher database are stored in this release. The "Snapshot Agent" user must have full access to this release. The "Merge Agent" user only needs read access.

6.7.3.2 Setting up the distributor

Requirement for the distributor

1. Create an "SQL Server Agent" user. The user must be directly or indirectly included in the following "User Rights Assignment Policies":
   - Log on as a service (SeServiceLogonRight)
   - Replace a process-level token (SEaignPrimaryTokenPrivilege)
   - Bypass traverse checking (SeChangeNotifyPrivileg)
   - Adjust memory quotas for a process (SelIncreaQuotaPrivilege)

2. Use the "Sql Server Management Studio" to assign the "sysadmin" server role to the "SQL Server Agent" account.

Note

You must assign the "sysadmin" server role using the "Sql Server Configuration Manager".

Rights on the distributor

- The "Merge Agent" and "Snapshot Agent" users must have the "db_owner" role in the "distribution" database. Select the "User Mapping" setting in the "Login Properties" window of the respective user to assign this role.
- Then select the "db_owner" role under "Database role membership for: distribution".
Setting up the distributor

1. Right-click in the "Object Explorer" context menu to open "Replication".
2. To start the "Configure Distribution Wizard", select "Configure Distribution...".
3. Click "Next" to exit the first dialog.
4. Confirm the default setting "'SQL-SVR2008-T01' will act as its own Distributor; SQL Server will create a distribution database and log" in the next dialog and continue with "Next".
5. In the next dialog, enter the previously configured snapshot release. Make sure that you enter the correct path for the Snapshot release.
6. In the next dialog, enter:
   - A name for the database
   - A storage location for the database
   - A storage location for the log files
7. Click "Add" in the next dialog to add the publisher. The distribution server must also be selected as publisher due to an error in the SQL Server.
8. Enter a password in the next dialog.
   You need the password to later set up a publication.
9. All settings are listed in the last dialog window:

   **Click Finish to perform the following actions:**
   
   - Configure distribution.

   **Distribution will be configured with the following options:**
   
   - Use 'SQL-SVR2008-T01' as the Distributor.
   - Use "\sql-svr2008-t01\RepData" as the root snapshot folder for Publishers using this Distributor.
   - Store the distribution database 'distribution' in "C:\Program Files\Microsoft SQL Server \MSSQL10_50\MSSQL\SERVER\MSSQL\Data".
   - Store the distribution database log file in "C:\Program Files\Microsoft SQL Server \MSSQL10_50\MSSQL\SERVER\MSSQL\Data".
   - Allow the following servers running SQL Server to use SQL-SVR2008-T01 as their Distributor:
     - SQL-SVR2008-T01
     - sql-svr2008-t05

Click "Finish".
The distributor is set up.
6.7.3.3 Setting up the publisher

Requirement for the publisher

1. Create an "SQL Server Agent" user. The user must be directly or indirectly included in the following "User Rights Assignment Policies":
   − Log on as a service (SeServiceLogonRight)
   − Replace a process-level token (SeAssignPrimaryTokenPrivilege)
   − Bypass traverse checking (SeChangeNotifyPrivilege)
   − Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)
2. Use the "Sql Server Management Studio" to assign the "sysadmin" server role to the "SQL Server Agent" account.

   Note
   You must assign the "sysadmin" server role using the "Sql Server Configuration Manager".

3. The Distributor has been set up.
4. SBM has to be set up for each publisher. See chapter Setting up SBM (Page 29).

Rights on the publisher

● The "Snapshot Agent" user must have the "db_owner" role in the published database. Select "User Mapping" in the "Login Properties" window of the respective user to assign this role. Then select the "db_owner" role under "Database role membership for: publication".
● The "MergeAgent" user must be a user in the published database but does not require any special properties.

Setting up the publisher

Setting up the publication

1. Click on "Objects Explorer" in the context menu and then on "Local Publications". The "New Publication Wizard" starts.
2. Select "New Publication".
3. Select the option "Use the following server as Distributor".
4. Click "Add..." to add the distribution server.
5. Enter the password you specified when you created the distributor.
6. In the next dialog, select the database that is to be published. Confirm with "Next".
7. Select "Merge Application" as publication type in the next dialog.
8. Select the version of the SQL Server, for example, "SQL Server 2008".
9. In the next dialog, select all tables or articles you wish to publish.
10. Add the "ROWGUID" column for each table added as an article. This column identifies the data record.

11. Click "Next" to skip the dialog for creating filters.

12. Select the check box for "Create a snapshot immediately". This way a snapshot is generated right after the publisher has been set up. Create additional snapshots only when prompted to do so.

13. Click "Security Settings...".

14. In the new dialog, select "Run under the following Windows account:" and enter the account of the Snapshot Agent.

15. To establish a connection with the publisher, select the option "By impersonating the process account". This means the previously specified Windows account is used. Alternatively, you can also use an SQL Server login. Make sure that the account has the appropriate access rights.

Note
The selected account, "repl_snapshot" in the example shown above, must have the "db_owner" property for the "distribution" database on the distribution server. The account must have the same property for the published database on the publisher server.

16. Confirm with "OK".

17. In the next dialog, select "Create the publication(s)" and confirm with "Next".
18. Your settings are listed in the final dialog window.

- Create the publication.
- Enter a name.
- Click "Finish".

The publisher is set up.

19. Once the publication has been created, open "Publication Access List" in the properties of the publication.

20. Add the users "Snapshot Agent", "Server Agent" and "Merge Agent" in the "Publication Access List".

6.7.3.4 Setting up subscriptions

Requirement for the subscriber

1. Create an "SQL Server Agent" user. The user must be directly or indirectly included in the following "User Rights Assignment Policies":
   - Log on as a service (SeServiceLogonRight)
   - Replace a process-level token (SeAssignPrimaryTokenPrivilege)
   - Bypass traverse checking (SeChangeNotifyPrivilege)
   - Adjust memory quotas for a process (SeIncreaseQuotaPrivilege)

2. Use the "Sql Server Management Studio" to assign the "sysadmin" server role to the "SQL Server Agent" account.

Note

You must assign the "sysadmin" server role using the "Sql Server Configuration Manager".

3. The distributor and publisher are set up.

4. SBM has to be set up for each subscriber server.

   See chapter Setting up SBM (Page 29).
Rights on the subscribers

- The "Merge Agent" user must have the "db_owner" role in the subscriber databases.

**Note**
If the databases are not created until you set up the subscription, assign the rights at a later time.

Setting up a subscription

1. To start the "New Subscription Wizard", open the context menu with a right-click on the previously created publication database in the "Object Explorer" and select "New Subscription...".

2. Select the previously set up publisher server and the configured publication database.

3. You specify the type of subscription in the next dialog. Select "Run all agents at the distributor" and confirm with "Next".

4. Next, add 3 subscriber servers. Click "Add SQL Server Subscriber...". Select an existing database from the drop-down menu or create new databases as target of the replication.

5. Define security settings for each of these created subscriber servers. To do so, click "..." in the last column of the table.
6. Make the settings in the dialog that opens analogous to the settings of the publisher. Enter the account under which the Merge Agent is being run. Also enter the type of connection to the SQL Server.

![Screenshot of the dialog for entering account and connection details]

**Note**

The selected user, "repl_snapshot" in the example shown above, must have the db_owner property in the distributor database and the subscriber database.

7. Repeat step 6 for all subscribers.

8. Once you have added the security settings for all subscriptions, close the dialog by clicking "Next".

9. In the dialog that opens, select the time when the Merge Agents are to be started. Select "<Define schedule...>" from the drop-down menu.

10. In the dialog that opens, select "Occurs every:" under "Daily frequency" and enter "1 minute(s)". Confirm with "OK".

11. Repeat steps 9 and 10 for all subscription databases.

12. In the next dialog, specify the time for initialization. Select "Immediately" for all subscription databases and confirm with "Next".

13. Assign the "Server" type to all subscribers and give each subscriber the same priority for conflict resolutions.
14. In the next dialog, select "Create the subscription(s)" and confirm with "Next".
15. Your settings are listed in the final dialog window:

The subscriptions are created and initialized with "Finish".

6.7.4 Alternative setup of the replication with TSQL scripts

6.7.4.1 Requirement for the use of TSQL scripts

You have set up servers, users and rights as described in the chapter Setting up the servers (Page 31).

6.7.4.2 Setting up the distributor

Requirement

Run the script on the distributor server.

Before you start the script, replace the following variables:

- <DServer>: Name of the distribution server
- <DPass>: Password for the distributor
- <PServer>: Name of the publisher server
- <PathToSnapshotsFolder>: UNC path to the snapshot folder
TSQL script

```sql
use master
exec sp_adddistributor @distributor = N'<DServer>', @password = N'<DPass>'
GO
exec sp_adddistributiondb @database = N'distribution', @data_folder = N'C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL\Data', @log_folder = N'C:\Program Files\Microsoft SQL Server\MSSQL10_50.MSSQLSERVER\MSSQL\Data', @log_file_size = 2, @min_distretention = 0, @max_distretention = 72, @history_retention = 48, @security_mode = 1
GO
use [distribution]
if (not exists (select * from sysobjects where name = 'UIProperties' and type = 'U ')) create table UIProperties(id int)
if (exists (select * from ::fn_listextendedproperty('SnapshotFolder', 'user', 'dbo', 'table', 'UIProperties', null, null)))
EXEC sp_updateextendedproperty N'SnapshotFolder', N'<PathToSnapshotFolder>', 'user', dbo, 'table', 'UIProperties'
else
EXEC sp_addextendedproperty N'SnapshotFolder', N'<PathToSnapshotFolder>', 'user', dbo, 'table', 'UIProperties'
GO
exec sp_adddistpublisher @publisher = N'<DServer>', @distribution_db = N'distribution', @security_mode = 1, @working_directory = N'<PathToSnapshotFolder>', @trusted = N'false', @thirdparty_flag = 0, @publisher_type = N'MSSQLSERVER'
GO
exec sp_adddistpublisher @publisher = N'<PServer>', @distribution_db = N'distribution', @security_mode = 1, @working_directory = N'<PathToSnapshotFolder>', @trusted = N'false', @thirdparty_flag = 0, @publisher_type = N'MSSQLSERVER'
GO
```

6.7.4.3 Setting up the publisher

Alternative setup of the publisher with TSQL script

Requirement

Run the script on the publisher server.

Before you start the script, replace the following variables:

- `<DServer>`: Name of the distribution server
- `<DPass>`: Password for the distributor
- `<Database>`: Name of the database to be published
- `<PubName>`: Name of the publication
• **<PServer>: Name of the publisher server**

• **<SUser>: Name of the snapshot user with domain (e.g.: winntnet\repl_snapshot)**

• **<SPass>: Password of the snapshot user**

**TSQL script**

```sql
use master
exec sp_adddistributor @distributor = N'\'<DServer>',
@password = N'\'<DPass>'
GO
use [\'<Database>\']
exec sp_replicationdboption @dbname = N'\'<Database>', @optname =
N'merge publish', @value = N'true'
GO
-- Adding the merge publication
use [\'<Database>\']
exec sp_addmergepublication @publication = N'\'<PubName>',
@description = N'Merge publication of database ''\<Database>'' from
Publisher ''\<PServer>''', @sync_mode = N'native', @retention = 14,
@allow_push = N'true', @allow_pull = N'true', @allow_anonymous =
N'true', @enabled_for_internet = N'false',
@snapshot_in_defaultfolder = N'false', @compress_snapshot = N'false',
@ftp_port = 21, @ftp_subdirectory = N'ftp', @ftp_login =
N'anonymous', @allow_subscription_copy = N'false',
@add_to_active_directory = N'false', @dynamic_filters = N'false',
@conflict_retention = 14, @keep_partition_changes = N'false',
@allow_sync_to_alternate = N'false', @max_concurrent_merge = 0,
@max_concurrent_dynamic_snapshots = 0, @use_partition_groups = null,
@publication_compatibility_level = N'100RTM', @replicate_ddl = 1,
@allow_subscriber_initialized_snapshot = N'false',
@allow_web_synchronization = N'false', @allow_partition_realignment =
N'true', @retention_period_unit = N'days', @conflict_logging =
N'both', @automatic_reinitialization_policy = 0
GO
exec sp_addpublication_snapshot @publication = N'\'<PubName>',
@frequency_type = 1, @frequency_interval = 0,
@frequency_relative_interval = 0, @frequency_recurrence_factor = 0,
@frequency_subday = 0, @frequency_subday_interval = 0,
@active_start_time_of_day = 500, @active_end_time_of_day = 235959,
@active_start_date = 0, @active_end_date = 0, @job_login =
N'\'<SUser>', @job_password = N'\'<SPass>', @publisher_security_mode = 1
use [\'<Database>\']
exec sp_addmergearticle @publication = N'\'<PubName>', @article =
N'COMOS_B_CDEVICE', @source_owner = N'dbo', @source_object =
N'COMOS_B_CDEVICE', @type = N'table', @description = null,
@creation_script = null, @pre_creation_cmd = N'drop', @schema_option =
0x000000010C034FD1, @identityrangemanagementoption = N'manual',
@destination_owner = N'dbo', @force_reinit_subscription = 1,
@column_tracking = N'false', @subset_filterclause = N'',
@vertical_partition = N'false', @verify_resolver_signature = 1,
@allow_interactive_resolver = N'false', @fast_multicol_updateproc =
N'true', @check_permissions = 0, @subscriber_upload_options = 0,
```

Hardware requirements

6.7 Combining several databases using merge replication
@delete_tracking = N'true', @compensate_for_errors = N'false',
@stream_blob_columns = N'false', @partition_options = 0
GO
use [<Database>]
exec sp_addmergearticle @publication = N'<PubName>', @article =
N'COMOS_B_CDEVSYMBOL', @source_owner = N'dbo', @source_object =
N'COMOS_B_CDEVSYMBOL', @type = N'table', @description = null,
@creation_script = null, @pre_creation_cmd = N'drop', @schema_option =
0x0000000010C034FD1, @identityrangemanagementoption = N'manual',
@destination_owner = N'dbo', @force_reinit_subscription = 1,
@column_tracking = N'false', @subset_filterclause = null,
@vertical_partition = N'false', @verify_resolver_signature = 1,
@allow_interactive_resolver = N'false', @fast_multicol_updateproc =
N'true', @check_permissions = 0, @subscriber_upload_options = 0,
@delete_tracking = N'true', @compensate_for_errors = N'false',
@stream_blob_columns = N'false', @partition_options = 0
GO
use [<Database>]
exec sp_grant_publication_access @publication = N'<PubName>', @login =
N'<SUser>'
GO
Note
The script shown above is only an excerpt. The highlighted script block only covers the article,
"COMOS_B_CDEVSYMBOL". The script block must be listed once again for each additional
article of the COMOS database to be published.
A list with the variables of the COMOS database is available in the section COMOS articles
(Page 41).

COMOS articles
Add the required articles to the TSQL script as illustrated in section Alternative setup of the
publisher with TSQL script (Page 39). Add the articles after "@article" and "@source_object",
respectively. Always observe this format:
● @article = N'<Variable>'
● @source_code = N'<Variable>'
For example: @article = N'LC_Case'
Here is a list of all possible COMOS articles:
● COMOS_B_CDEVICE
● COMOS_B_CDEVSYMBOL
● COMOS_B_CLINK
● COMOS_B_CONNECTOR
● COMOS_B_D3
● COMOS_B_DEVICE
6.7 Combining several databases using merge replication

- COMOS_B_DOCOBJ
- COMOS_B_DOCTYPE
- COMOS_B_DOCUMENT
- COMOS_B_PHYSUNIT
- COMOS_B_PHYSUNITGROUP
- COMOS_B_RIGHT
- COMOS_B_SPEC
- COMOS_B_SPECTSET
- COMOS_B_STANDARDTABLE
- COMOS_B_STANDARDVALUE
- COMOS_B_XOBJ
- COMOS_B_XROP
- LC_CASE
- LC_CDEVIVE
- LC_CDEVSsymbol
- LC_CLINK
- LC_CONNECTOR
- LC_D3
- LC_DEVICE
- LC_DOCOBJ
- LC_DOCTYPE
- LC_DOCUMENT
- LC_ERROR
- LC_HIERARCHY
- LC_IMPORT
- LC_LANGUAGE
- LC_LASTTIMES
- LC_NRG_ASSIGNMENTS
- LC_NUMBER_RANGE_GENERATOR
- LC_OBJREV
- LC_OVERLAY
- LC_PHYSUNIT
- LC_PHYSUNITGROUP
- LC_PICKLIST
- LC_PICKLISTENTRY
Alternative setup of the subscriber with TSQL script

**Requirement**

Run the script on the publisher server.

Before you start the script, replace the following variables:

- `<Database>`: Name of the database to be published
- `<PubName>`: Name of the publication
- `<SServer1>`: Name of subscriber server 1
- `<SDatabase1>`: Name of the database on subscriber 1
- `<SubUser>`: Name of the Merge user with domain (e.g.: winntnet\repl_merge)
- `<SubPas>`: Password of the Merge user

**TSQL script**

```sql
use [<Database>]
exec sp_addmergesubscription @publication = N'<PubName>',
@subscriber = N'<SServer1>', @subscriber_db = N'<SDatabase1>',
@subscription_type = N'Push', @sync_type = N'Automatic',
@subscriber_type = N'Global', @subscription_priority = 75,
@description = null, @use_interactive_resolver = N'False'
exec sp_addmergepushsubscription_agent @publication = N'<PubName>',
@subscriber = N'<SServer1>', @subscriber_db = N'<SDatabase1>',
@job_login = N'<SubUser>', @job_password = N'<SubPass>',
```
@subscriber_security_mode = 1, @publisher_security_mode = 1,
@frequency_type = 4, @frequency_interval = 1,
@frequency_relative_interval = 1, @frequency_recurrence_factor = 1,
@frequency_subday = 4, @frequency_subday_interval = 1,
@active_start_time_of_day = 0, @active_end_time_of_day = 235959,
@active_start_date = 20120101, @active_end_date = 99991231,
@enabled_for_syncmgr = N'False'
GO

**Note**

The script shown above is only an excerpt for a subscriber server. The script must be executed once again for each additional subscriber server that is used. For additional servers, adjust the variables <SServer1> and <SDatabase1> to those of the respective server.

---

### 6.8 Infrastructure requirements for clients

#### 6.8.1 Standard clients

COMOS 10.1 was developed primarily in WPF and Dot.Net. The WPF technology enables an, up-to-date user interface according to the newest ergonomic standards. This technology requires a graphic card with support of the interface by the hardware.

The total performance of the application increases significantly when you use a dual-core processor with sufficient RAM.

**Technical background**

Approx. 512 MB RAM are sufficient for Windows XP. For this reason we recommend 4 GB RAM as main memory for Windows 7. Common PCs make about 3.5 GB of this memory available to the operating system. This covers the additional memory requirements for Windows 7.

**Hardware for standard clients**

- Random Access Memory (RAM)
  
  2 GB RAM

- Processor
  
  Dual core CPU > 2.46 GHz (Athlon X2 5xxx or Intel E7xxx)
  
  Additionally recommended: Quadcore CPU

- Hard disk
  
  SATA hard disk, approx. 2 GB free storage memory

- Graphic card
  
  Graphic card with 1 GB memory and DirectX 9.0c
• Network
  100 Mbit Ethernet
• Operating system
  Windows

6.8.2 Citrix clients
Either thin clients are used for COMOS which are suitable for Citrix XenApp 6.0 or PCs with basic equipment.

Hardware for Citrix clients
• RAM
  512 MB RAM
• Processor
  2 GHz CPU
• Hard disk
  SATA hard disk
• Graphics card
  Separate graphics card with medium performance characteristics
  Current recommendation: Use the same graphics card that is recommended in the standard client.
• Network
  – At least a 1 Mbit bandwidth and latent times below 50 ms.
  – In the current use, peak demands remain slightly below 1 Mbit. Also take 3 Mbit lines into consideration for future infrastructure planning.
  – Recommendation: 100 Mbit Ethernet or WAN-enabled network interfaces
• Peripherals
  One or two monitors with 1280 x 1024 resolution
  For 1680 x 1050 resolution in dual-monitor operation on Citrix you must reduce the color depth to 16-bit.
• Operating system
  See also section Citrix (Page 18).
6.9 Infrastructure requirements for servers

6.9.1 Database server prerequisites

Supported database systems

- Microsoft SQL Server
- Oracle
- Microsoft Access database files
  Only Microsoft SQL Server and Oracle are considered below.
- Supported versions for Oracle and Microsoft SQL Server:
  - 32-bit version
  - 64-bit versions

For professional use, Microsoft SQL Server or Oracle is recommended. The use of a local Access DB is only practical for test purposes.

Hardware requirements for initial configuration

We recommend the following hardware features for Microsoft SQL Server and Oracle:

- RAM
  8 GB as standard for databases
- Processor
  CPU >= 2 GHz, dual core for > 10 users
  Recommendation: Calculate one CPU core for every 20 registered users.
- Network
  1 Gbit Ethernet
- Hard disk
  Initial size of a COMOS database with SQL: approx. 2-3 GB
- Data backup
  Back up your databases regularly.

Microsoft SQL Server

COMOS works seamlessly together with a hot standby cluster configuration on the Microsoft SQL Server.

Comparison of the servers

COMOS achieves a significantly higher performance with database-dependent operations by using Microsoft SQL servers.
Storage space requirements

The increase in size of the database file depends on how many new objects and documents are created.

- Microsoft SQL Server
  Large COMOS installations with 100 clients can reach a database size of 100-500 GB on a Microsoft SQL Server after 5 years of operation.

- Oracle
  Under Oracle the storage space is managed differently. Here the database files are 50-75% smaller when compared to the Microsoft SQL Server.

Large installations

No recommendation is made for the design of a database server which supports hundreds or thousands of concurrent users and databases exceeding a volume of 100 GB. The design of a database server is customer-specific and depends on the product portfolio which you can access from your hardware vendor.

Requirements for the COMOS Mobile Solutions 1.0 solution

See chapter Software requirements for COMOS Mobile Solutions (Page 21).

6.9.2 File server

The file server has to provide a release for all users of the database. This release is realized by means of a file server or an appropriate NAS device. NAS devices have to support "DSO file properties".

Hardware for a file server

- RAM
  4 GB RAM

- Processor
  2 GHz CPU

- Hard disks
  Hard disks for COMOS documents as Raid 1, Raid 5 or NAS.

- Network
  1 Gbit Ethernet

- File system
  NTFS file system for COMOS documents

- Operating system
  Any
  Recommended: Windows Server 2008 R2

As delivered, the COMOS document directory contains less than 1 GB of data.
6.9.3 Licence server

The license server has few requirements regarding the hardware.
A PC with standby backup is sufficient. COMOS clients bridge a downtime of up to 10 minutes.
The license server runs with an Aladdin Hardlock USB dongle and license files. Dongles for
single-station licenses are also possible.

Hardware for a license server

- RAM: 4 GB
- Processor
  2 GHz CPU
- Network
  Ethernet 100 Mbit
- Hard disks
  SATA hard disk
- Peripherals
  One free USB port.

To also run in VMWare, the license server requires a dedicated USB port (VMWare 7) or a
dongle server (AnywhereUSB).

AnywhereUSB with Multihost option

A second backup license server including backup dongle and license file can be installed for
the license server.

6.9.4 COMOS Web

COMOS Web provides a part of the functional scope of COMOS via an integrated Web server.
A Web browser as a client is sufficient.

Hardware for COMOS Web

- RAM
  4 GB RAM
- Processor
  Quad-Core, 2 GHz
- Hard disks
  2x 74 GB mirrored hard disks
- Network
  1 Gigabit Ethernet
• Graphic
  Onboard graphic is sufficient

• Operating system
  See also section Software requirements for COMOS Mobile Solutions (Page 21).

**Additional resource requirements under COMOS Web**

The specified resources are sufficient for 10 users. Additional resources are needed for more users.

- Per user: approx. 300 MB RAM
- Per user ca. 20% of a CPU core

**Hardware for COMOS DocumentView**

An additional installation of SharePoint is required for COMOS DocumentView.

- Processor
  Quad-Core

- RAM
  8 GB RAM

**6.9.5 COMOS Enterprise Server**

The COMOS Enterprise Server is responsible for data import/export from external data sources. The data is transported by means of XML files. Data are automatically transferred from SAP, for example.

**Hardware for a COMOS Enterprise Server (1-2 instances)**

- RAM
  4 GB RAM

- Processor
  Dual core CPU 2 GHz

- Hard disks
  2x 74 GB mirrored hard disks

- Network
  1 Gigabit Ethernet

- Graphic
  Onboard graphic is sufficient

- Operating system
  Windows Server 2008 R2 SP1, Windows Server 2012
**Additional resource requirements under COMOS Enterprise Server**

The COMOS Enterprise Server can be operated in multiple instances. A CPU core is almost fully utilized by one instance when extensive data amounts are imported. In addition, up to 2 GB of storage per instance is required. The required memory depends on the amount of data to be imported and the number of operations conducted on the data.

For extensive import procedures, provide one CPU core per instance and 2 GB of RAM.

**See also**

[Enterprise Server](Page 20)

---

**6.9.6 Citrix server**

- **RAM**
  - At least 4 GB RAM
  - Depending on the number of users 8 to 16 GB RAM
    
    See further below for additional information about the resource requirements.

- **Processor**
  Quadcore CPU 3 GHz

- **Hard disks**
  2x 74 GB mirrored hard disks

- **Graphic**
  Onboard graphic is sufficient

- **Network**
  Gigabit Ethernet

- **Operating system**
  
  See also section [Citrix](Page 18).

---

**Additional resource requirements for the server under COMOS**

- Per standard user 500 MB RAM.
- Per power user 1 GB RAM.
- A separate CPU core for every 3-4 users.

The WPF interface of COMOS supports multithreading for interface rendering. Here, at least 4 CPU cores with the highest performance are required for the basic equipment of the server.
Prepare network login

7.1 Definition of the three types of logins for COMOS users

Working locally

If you are working with an Access DB which is available locally on the computer, you do not require any network rights.

Storage structures in a client/server structure

Standard workflow:

- The individual users have installed the COMOS software on their PCs ("workstations"). The user is not an administrator, neither on the PC nor in the network.
- The data is managed centrally in the network. Thus, the PCs of users are "clients" and access a common "server". Take the following information into account:
  - Everything that is referred to as an "object" in COMOS originates from the actual database.
  - The server on which the COMOS database is located is called the "database server".
  - Everything that considered a "Document" or "File" in COMOS is stored independently as a physical file and saved in the "Document folder".
  - The document folder is located on the database server or on a separate server. If the document folder is located on a separate server, this server is called the "document server" or "file server".

Types of login when working with a client/server structure

When working with a client/server structure, the following logins are required:

1. Client login at the database server
   To do this, a kind of "network user", a so-called "System DSN", must be set up on the client in the "ODBC data sources administrator". See also Chapter Database server login using DAT password file (Page 52). The counterpart to this occurs in the user management of the database server: there, a user is set up with exactly the same name as the login ID of the "System DSN" on the client. This user then gets the required rights to the database server.

2. Login to the file server
   The required rights on the file server are given to the user of the workstation.

3. Login to COMOS, the "COMOS login"
   Only at this point does the COMOS rights administration take effect.

See also

Securing network access with network login (Page 53)
7.2 Database server login using DAT password file

Access via a DAT file

COMOS uses a System DSN to find a data source. However, the login ID and password are normally taken from an encoded DAT file and not from the System DSN. You can change the password later for all clients by replacing the DAT file.

Procedure

To set up automatic access to the database server, proceed as follows:

1. Install the database server and the clients.
2. Create a system DSN on a client as follows:
   - Log into COMOS on the same PC and search for the System DSN. Since a DAT file does not exist at this moment, the login window for the login to the database server appears in COMOS.
   - Enter the login ID and password in the login window. If COMOS logs into the database server with this information, it automatically generates an encoded DAT file. This DAT file is independent of the station.
   - Create the System DSN for all other clients.
   - Distribute the DAT file that has been created.

The login window in COMOS is circumvented and the users work without having to enter a password.

Automatically creating a DAT file

When a server database is opened and an instance does not exist yet, a DAT file is created. For instance 3, there is no DAT file.

See also

- Securing network access with network login (Page 53)
- Distributing a DAT file (Page 56)

7.3 Configuration of the operating system

Purpose

With Network Login, an additional account is set up which performs the login on the network as a proxy of the COMOS user. See chapter Aim of the network login (Page 53) for more on this. With certain operating systems, security policies have to be adjusted before this procedure is permitted.
If Network Login is not allowed by the operating system, adjust the following local security policies (example given based on Windows 2000):

1. In the Windows Start menu, select the command "Settings > Control Panel > Administration > Local Security Policy".
2. Select the folder "Security Settings > Local Policies > User Rights Assignment".

"Act as part of the operating system" policy
1. Open the properties of the "Act as part of the operating system" policy.
2. Click "Add".
3. Add "Everyone" to the list at the bottom.
4. Confirm twice with "OK" and close all open windows.
   The policy has now been changed.

"Replace a process level token" policy
COMOS must be authorized to call the operating system function CreateProcessAsUser. For this purpose, the "Replace a process level token" policy must be changed:
1. Open the properties of the "Replace a process level token" policy must be changed:
2. Enable the policy for all users that use COMOS.
   You can also make an entry in the "Everybody" list at the bottom.
3. Confirm twice with "OK".

"Create a token object" policy
The "Functional account" that was set up for anonymous data access must be entered here.
If your administrator has defined policies for the domain that overwrite these local policies, then the changes to the local security policies will not take effect. In this case, the administrator must modify the domain-level security policies accordingly.

7.4 Securing network access with network login

7.4.1 Aim of the network login

Requirement

- The various logins are clear.
  See Chapter Definition of the three types of logins for COMOS users (Page 51).
Aim

The "network login" function restricts the direct (COMOS-independent) access to the document directory of a COMOS project. Network login is available for:

- Oracle
- MS SQL Server

Other functions which protect document access

External documents can also be protected using the "Check out" and "Check in" functions. You can find more information on this topic in the "COMOS Platform Administration" manual, keyword "Configuring external editing of documents".

See also

Overview of the network login sequence (Page 54)

7.4.2 Overview of the network login sequence

Requirements

- You understand the purpose of the network login.
  See Chapter Aim of the network login (Page 53).

Operational principle of network login

In addition to the COMOS user logins, a domain user is also created. When the network folder containing the COMOS documents is accessed from COMOS, the system switches automatically to the domain user. Once the folder has been accessed, the system switches back to the user that is logged into the station. Outside of COMOS, access to the network folder containing the COMOS documents can be prevented.

Alternative rights concepts for network access

You can set up network access for COMOS users via Network Login in three ways:

- Grant full access to the document directory for all COMOS users working with Network Login.
- Set up a Network Login user with full access and grant read rights to the individual COMOS users.
- Set up a Network Login user with full access and grant the "List folder content" right to the individual COMOS users. This option is recommended for security reasons.

Note: Up until Windows 2000, the security policies needed to be adapted manually for network access. This is not necessary for current operating systems.
Network access using UNC address

Use the UNC address to address the document directory of the database.
Correct: \<Server name>\<COMOS document directory>
Incorrect: O:\<COMOS document directory>

See also
- Protected login names (Page 55)
- COMOS rights relating to network login (Page 55)
- Calling up the Network Security Configuration Tool (Page 56)

7.4.3 Protected login names

Requirements
- You understand the network login overview.
  See Chapter Overview of the network login sequence (Page 54).

Names with a fixed meaning

For compatibility reasons, the user name "Comos" or "comos" is not available. If you use this name, COMOS attempts to login without a password.

See also
- Calling up the Network Security Configuration Tool (Page 56)

7.4.4 COMOS rights relating to network login

Requirements
- You understand the network login overview.
  See Chapter Overview of the network login sequence (Page 54).

Access via script

For security reasons, COMOS users are not allowed to have scripting rights. To turn off the scripting rights, deactivate the "Object debugger" function right in COMOS.

See also
- Calling up the Network Security Configuration Tool (Page 56)
7.4.5 Calling up the Network Security Configuration Tool

Requirements

- You understand the network login sequence.
  See Chapter Overview of the network login sequence (Page 54).

Overview

The "Network Security Configuration Tool" is used to store the domain user for the network login.

Procedure

1. Open the application "NetLogin.exe" under "<Installation directory>\Comos\<COMOS Version directory>\BIN".
   The "Network Security Configuration Tool" window is opened.
2. Select a database.
3. Enter the login information in the "Database user name" and "Database password" fields.
4. Click the "Edit configuration data" button.
   If you are entitled to carry out configuration, the following fields are displayed.
   - "Domain"
   - "User name"
   - "Password"
5. Enter the information of the domain user in these fields.
6. Click "OK".

See also

Distributing a DAT file (Page 56)

7.4.6 Distributing a DAT file

Requirements

- You are familiar with the Network Security Configuration Tool.
  Calling up the Network Security Configuration Tool (Page 56)

Name of the configuration file

The configuration data is saved in a configuration file:

<xxx>PWD<n>.DAT
Depending on the database system used, \(<xxx>\) has either the value ORA (for Oracle) or SQL (for MS SQL Server).

\(<n>\) represents the instance used (blank stands for the default instance, otherwise "\(_1\)" or "\(_2\)").

### Filing place of the configuration file

As of COMOS 9.0: "\(<\text{COMOS installation directory}>\Config\)"

### Examples

- ORAPWD.DAT
- SQLPWD_1.DAT.

You can either repeat the configuration settings for each COMOS installation or distribute the DAT file to the various installations.

### See also

[Database server login using DAT password file (Page 52)]

### 7.4.7 Reestablishing access to connected network drives

#### Overview

For safety reasons, a setting was changed for Microsoft. With the following operating systems, the \texttt{ProtectionMode} key is entered and activated:

- Windows Server 2003
- Windows XP SP3

#### Effect

This has an effect on updates and upgrades. In some cases, existing software environments may no longer work.

Connected drives may no longer be visible to other users. This also means that encapsulated access to the COMOS document folder no longer works.

You can no longer use the network login if you install one of the following operating systems on a computer and retain the default settings:

- Windows Server 2003
- Windows XP SP3
This is also the case when you update an existing operating system to one of the listed operating systems and retain the default settings.

**Note**
Please test updates and upgrades of Microsoft operating systems in a protected environment first before changing productive environments.

### Procedure
In order to use the network login again, change the following key in the registry and then restart the PC:

```
HKEY_LOCAL_MACHINE \SYSTEM\CurrentControlSet\Control\ SessionManager \ProtectionMode
```

**Default:** ProtectionMode = 1  
**Set to:** ProtectionMode = 0
If this key was manually entered for an operating system other than those mentioned above, it must be set to "0 there, too.

### Case study
Citrix server based on Windows Server 2003:
- **ProtectionMode** is set to "1" by Windows Server 2003.
- To use network login, the user sets ProtectionMode back to "0".
  
The user profiles saved on the Citrix Server can no longer be used as they cannot be loaded onto the Clients during login.

If you switch to ProtectionMode = 1, the original status is restored. You can then no longer use network login.

### 7.5 Programming extensions for network login

#### 7.5.1 Class IComosDAutoNetworkLogin

**Constructor/destructor**
- **Constructor**  
  In the constructor of this object, the system automatically switches to the correct user for the requested file access.
- **Destructor**  
  The system automatically switches back to the user who started the COMOS application.
7.5.2 Class IComosDWorkset

Function NetworkLogin

Function NetworkLogin(
    FileName As String, _
    FileAccessMode As Long) As IComosDAutoNetworkLogin

Generates a new IcomosDAutoNetworkLogin object. This function must always be called before accessing a file. The IcomosDAutoNetworkLogin object that is returned must be destroyed directly after opening the file. Access rights are preserved until the file is closed.

<table>
<thead>
<tr>
<th>FileName</th>
<th>Name of the file (full path) that is to be accessed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>FileAccessMode</td>
<td>Mode for the requested file access.</td>
</tr>
<tr>
<td>NetworkLoginDefault (0):</td>
<td>Read access</td>
</tr>
<tr>
<td>NetworkLoginRead (1):</td>
<td>Read access</td>
</tr>
<tr>
<td>NetworkLoginWrite (2):</td>
<td>Write access</td>
</tr>
<tr>
<td>NetworkLoginReadWrite (3):</td>
<td>Read and write access</td>
</tr>
<tr>
<td>NetworkLoginAppend (8):</td>
<td>Append to a file</td>
</tr>
</tbody>
</table>

Note

FileAccessMode is not analyzed at present, but is provided for a future use and therefore must always be set correctly.

The constants correspond to those of the FileSystemObject of the operating system.

7.5.3 Interaction between network login and XStdMod.Dll

Function ComosOpenTextFile

Creates a new text file. The user is switched before creating the file. The parameters and their meaning are the same as for FileSystemObject.OpenTextFile.

Function ComosOpenTextFile (  
    ByVal Filename As String, _   
    Optional ByVal Mode As IOMode = ForReading, _   
    Optional ByVal Create As Boolean = False, _   
    Optional ByVal Format As Tristate = TristateFalse) As TextStream
Function ComosCopyFile

Copies the file specified in SourceFilename to TargetFilename. If the file TargetFilename exists, it is overwritten if Overwrite has the value True.

Function ComosCopyFile(
    ByVal SourceFilename As String, _
    ByVal TargetFilename As String, _
    ByVal Overwrite As Boolean) As Boolean

7.5.4 Interaction between network login and COMOS.dll

Access for COMOS.dll to the document folder

The following applies to all methods from the COMOS.dll that access the COMOS document folder:

These methods have been implemented in such a way that they carry out the Network Login automatically. When a software developer calls such a method, the developer does not need to worry about the Network Login, the method does this for him.
8.1 Important note for Windows 7 and Windows Server

The following information applies for installing COMOS, COMOS licensed products and COMOS add-on programs with a separate installation routine.

No direct start of installation

Under the following Microsoft operating systems, you do not start the installation (PC installation, Client installation or Citrix Server installation) directly via the installation link in the HTML interface of the Setup browser:

- Windows 7
- Windows Server 2008
- Windows Server 2008 R2
- Windows Server 2012

Reason: The security settings for administrative applications in the User Account Control (UAC)

Start installation for these operating systems

1. Start the Setup browser. See also chapter COMOS Setup browser: Start window (Page 71).
2. Select the required product in the navigation area.
3. Follow the instructions you find in the detail section of the Setup browser under the note for Windows 7.
4. The InstallShield Wizard will guide you through the installation. Also see the corresponding subsection of this chapter for installation routine details Installing COMOS with the Setup browser (Page 71)
Alternatively: Start the installation from the Windows Explorer

1. Open a file explorer.
2. Depending on the required product, open the file explorer to the following directory:

<table>
<thead>
<tr>
<th>Product</th>
<th>Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>COMOS</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Inst-Comos&quot;</td>
</tr>
<tr>
<td>COMOS PDMS Integration</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Inst-Pdm&quot;</td>
</tr>
<tr>
<td>COMOS Plant Modeler</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Inst-Plm&quot;</td>
</tr>
<tr>
<td>COMOS Enterprise Server</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Inst-EntrPrSvr&quot;</td>
</tr>
<tr>
<td>COMOS Walkinside</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Inst-Walkinside&quot;</td>
</tr>
<tr>
<td>License management</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Lic-Management&quot;</td>
</tr>
<tr>
<td>License Server Monitor</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Lic-ServerMonitor&quot;</td>
</tr>
<tr>
<td>Remote License Service</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Lic-Remote&quot;</td>
</tr>
<tr>
<td>User Manager</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\Lic-UserManager&quot;</td>
</tr>
<tr>
<td>COMOS TIFF Printer</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\AddOn-TiffPrinter&quot;</td>
</tr>
<tr>
<td>COMOS TIFF Server</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\AddOn-TiffServer&quot;</td>
</tr>
<tr>
<td>Teamcenter FCC</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\AddOn-Tc&quot;</td>
</tr>
<tr>
<td>SIMATIC XML Transfer</td>
<td>&quot;...\Setup-Browser\SetupCallers&lt;Language&gt;\AddOn-SimXmlTfer&quot;</td>
</tr>
</tbody>
</table>

3. Select the command "Start as administrator" from the context menu of the "setup.exe" file.

8.2 Terminal Server: CLS Remote License Service

If you work with the Terminal Server, use one of the following tools on the client side:

- COMOS ICA Client
  The COMOS ICA Client is used only in connection with the Citrix Server.
  See also section [Third party licenses of a Citrix environment](Page 63).
- CLS Remote License Service
  Additional information on this topic can be found in the "COMOS Platform Administration" manual under the keyword "Using the Remote License Server".

8.3 Installing COMOS with 4 GB support

COMOS with 4 GB support

COMOS only uses 2GB of RAM by default. Within the scope of the standard COMOS installation, the following file is installed:

<COMOS-Pfad>\BIN\comos4g.exe

When you run this exe file, COMOS is started with support for 4 GB of ram. The COMOS version with support for 4 GB of ram is not suitable for mass data operations.
You can find additional information on this topic in the "COMOS Platform Administration" manual, keyword "Logon with 4 GB of support".

8.4 Installing COMOS on Citrix

8.4.1 Third party licenses of a Citrix environment

The licenses for the Citrix server and Microsoft Terminal server are generally not covered and must be purchased by you.

8.4.2 COMOS licenses for a Citrix environment

The following scenarios may apply in connection with the required COMOS license in a Citrix environment:

Internal domain

- Requirement:
  - Citrix server and client are in the same domain.
  - Domain membership of the client can be determined by COMOS when it is started on the Citrix server.
  - The COMOS license server is configured on the Citrix server.
- For various reasons, Comos may fail to detect the domain of the Citrix client. The domain membership of the client is not recognized:
  - Firewall of the Citrix client blocks "File and Printer Sharing"
  - Access via a Citrix Web interface: A setting called "Web interface generates client name" or "Dynamic device name" is enabled. You can disable this setting as of Citrix Presentation Server 4.5.
    1. Open the "Citrix Access Management Console" window.
    2. Open the "Manage session settings" window.
    3. Click in the "Remote compound" group on the "Clientname" entry.
    4. Disable the "Web interface overwrites ICA client name" option.
  - User profile: The "Refuse" right was assigned for calling components via the network. The "Refuse" right is a setting in the rights management of Windows Active Directory. Active Directory is a rights management utility for computer networks with Windows servers and PCs.
    Despite membership of the client in the server domain, COMOS additionally demands an external access license in this case. Contact the support team.
Access to a Citrix Server is conducted from outside

- Using an external Citrix client
  For external employees, such as service providers, you need an additional external access license in order to open the COMOS database, regardless of the module used.

- Access via own COMOS Citrix client ("Comos ICA client").
  The COMOS ICA client either has its own local license or its own license manager has previously been configured. The latter requires that a COMOS ICA client also has access to the license manager server and is, therefore, located in the same network.

You can obtain more information in the price and product catalog.

8.4.3 Installation overview for Citrix

1. Installing the Citrix server
   To learn about the installation of Citrix Presentation Server or "XenApp Plugin for Hosted Apps" (new product name), refer to the Citrix documentation. Released version: See also section Citrix (Page 18).

2. Installation of COMOS on the Citrix Server
   See also section Start the installation on Citrix (Page 65).

3. Making COMOS available on a Citrix Server
   See also section Citrix Delivery Services Console (Page 65).

4. Installing Citrix clients
   See also section Configuring a Citrix ICA Client (Page 66).

8.4.4 Printers in Citrix environments

TIFF

A TIFF printer driver is supplied with COMOS. There is a separate version of the TIFF printer driver that you must use on Citrix servers.

See also section Installing "COMOS TIFF server" (Page 87).

Local printers

You can configure the ICA clients in such a way that the local printers are addressed instead of the Citrix server printers. See also section Server settings (Page 66).

The complete installation of a Citrix environment is described in the Citrix documentation.
8.4.5 Installing COMOS on the Citrix server

8.4.5.1 Start the installation on Citrix

Proceed as described in section Important note for Windows 7 and Windows Server (Page 61).

8.4.5.2 Citrix Delivery Services Console

Proceed as follows to prepare COMOS by means of Citrix XenApp 6 or 6.5:

1. Select the following node in the Citrix Delivery Services Console: "Citrix Resources > XenApp > QSCitrix > Publish applications"
   The "Publish applications" window opens with the category of "Welcome".
2. Click "Next".
3. Assign an appropriate display name and application description in the category "Name".
4. Click "Next".
5. Select the following settings in the category "Type":
   – Activate the option "Application".
   – Group "Application type": Activate the option "Access from a server". Select "Installed application" in the list "Server Application Type".
6. Click "Next".
7. Enter the COMOS installation path in the category "Storage location".
8. Click "Next".
9. Specify in the category "Server" which servers host COMOS.
10. Click "Next".
11. Specify in the category "User" which users can see and start COMOS.
12. Click "Next".
13. Optional: Specify a client application folder in the category "Link representation".
14. Click "Next".
15. Click the "Finish" button in the category "Publish immediately" to complete the configuration. COMOS is now available in the web interface.

See also

ICA connection to COMOS (Page 66)

8.4.5.3 Novell Networks

There is no release for mixed networks, e.g. if an MS server is working in a Novell network.

The workgroups of Novell networks are not supported.
8.4.6 Configuring a Citrix ICA Client

8.4.6.1 COMOS ICA Client

The CLS ICA client is technically identical to the commercial Citrix clients. A requirement however is, that the client workstation must have an installation-compatible working environment. Clients on which no independent programs can be installed are not suitable for the CLS ICA client.

8.4.6.2 Different access modes on Citrix servers

COMOS licensing makes a distinction depending on whether the client and Citrix Server belong to the same Windows domain. The access mode differs depending upon whether or not the domain is recognized.

- Citrix ICA Client
  Determines the domain.

- Citrix web interface
  Does not detect the domain.

The installation has a decisive influence on which COMOS license you can use. See also section [Third party licenses of a Citrix environment](Page 63).

8.4.6.3 Server settings

You can configure the Citrix ICA client at the server end or client end.

The suggested settings in the following "Edit Connection" window are not mandatory, but they have been tested.

"Advanced..." button

Select "reset" in the "On a broken or timed-out connection" list either here with the setting at the server end or client end.

"Client Setting..." button

No special requirements from COMOS. Regard the general principles of performance monitoring.

8.4.6.4 ICA connection to COMOS

Add the new ICA connection.

In the next window, assign an appropriate name to the connection. Select the following:

- Network protocol: "TCP / IP"
- Connection to: "Published Application"

Click the "Server Location..." button.
In the next window, add a new server with the IP address "192.168.119.10".

Specify application

In the list where the "Published Application" option is enabled, specify the configured COMOS application, e.g. "COMOS 7".

The "Published Application" option was previously entered as an "Application" in the Citrix Presentation Server. See also section Citrix Delivery Services Console (Page 65).

8.4.6.5 Client settings

ICA settings - "General" tab

Set "Client Name" on the server, click the "Pass-Through Authentication" option.

Properties of the ICA client

"Connection" tab

"Standard Options" tab
"Login information" tab

- **Local user**
  - Pass through authentication
- **Smart card**
  - Pass through authentication
- **User-specified credentials**
  - **User name**
  - **Password**
  - **Domain**

[Options for different configurations]
8.4.6.6 Windows Server operating systems

If a Windows Server operating system is used as the terminal server, there is a "Remote Desktop Users" group in the group management. In this group, enter the user names of the people who want to start this session.

Alternatively, enable terminal server permission individually for each user in the user properties.

8.4.7 DBMon Outputs

Debug view does not have to be started separately as of COMOS 9.0.

When you start COMOS, a log runs automatically. This log file is automatically written to the following directory:

"<home root> \Documents and Settings \<User> \Local Settings \Application Data \Comos_Industry_Solutions \Listeners \Comos_Log_<Date>.log"

Example:

"c:\Documents and Settings\fro\Local Settings \Application Data \Comos_Industry_Solutions \Listeners \Comos_Log_2009_06_24_11_49_26.log"

8.4.8 FAQs

COMOS does not open

The following causes are possible:

- No free license available for COMOS.
  Purchase additional licenses.
- The Citrix administration is erroneous.
  Check "Released applications" or "User-defined connection".

COMOS opens, but is "empty"

The following cause is possible:

- The "user" for the login to Citrix and the "user" in COMOS were spelled differently, or no corresponding "user" has yet been specified in COMOS.
  You will be logged onto both the external domain and COMOS using this information. The user name has to be exactly the same for both registrations. Please make sure that the user name in COMOS is the same as the user name for the domain and that the user in COMOS has the required rights.
COMOS is not fully visible

The following cause is possible:

- The window of the COMOS ICA client is too small.
  Check if the right information has been entered in the "Options".
  The "size" in the COMOS ICA client options defines the maximum size in which COMOS is visible.
  You cannot change the width and height of the COMOS ICA client window while using COMOS.
  Close the COMOS ICA client before you enter new options.

The operation of COMOS is somehow "distorted"

The following cause is possible:

- Differing settings on the Citrix server for mouse, keyboard, etc.
  The settings of the Citrix server apply within the client window, not your own settings.
  This applies especially to the mouse settings, which can be set differently (e.g. for lefties).
  During the installation of the Citrix ICA client, select the "Desired function: Maintain local settings" option.

The screen flickers or the display is askew

The following cause is possible:

- With Citrix 4.5: The domain user is not a local administrator
- With Citrix 4.5: The domain user does not have local administrator rights on the terminal/Citrix server.

This behavior is a standard problem for modern software that works with WPF.

Cause: Permission problems

WPF writes the "d3d9caps.dat" to "c:\windows\system32" or "%windir%\system32" file.

The "d3d9caps.dat" file contains the information that the Citrix client sent to the server concerning the graphic capabilities of the client.

Microsoft has confirmed this as an error and offers a hotfix. These problems are almost always fixed with the "KB955692" patch from Microsoft:

After applying the hotfix, the "d3d9caps.dat" file is saved as follows by default:

"%userprofile%\local settings\application data\"

In this directory the signed-in user usually has unrestricted rights and the above behavior no longer occurs.

See also

Microsoft - Help and Support (http://support.microsoft.com/)
8.5 Installing COMOS with the Setup browser

8.5.1 Software requirements

Software requirements for Windows: See also section COMOS client (local installation) (Page 17).

8.5.2 COMOS Setup browser: Start window

Requirement

Microsoft Internet Explorer 8 or higher

If you are using an older version of the Internet Explorer, start the installation steps manually in the directory structure of the CD. These include, for example, unpacking the COMOS database or starting "setup.exe" with the "Run as administrator" command from the context menu.

Starting the Setup browser

Insert the COMOS CD. The Browser starts automatically. If there is no autostart, start the "index.html" file on the CD.

With some systems, a security prompt is displayed the first time the COMOS Setup browser opens. For example "To help protect your security...". Click this button to allow the blocked content.
Installing COMOS and additional software

8.5 Installing COMOS with the Setup browser

User interface areas

The user interface of the COMOS Setup browser is divided into the following areas:

1. Menu bar (horizontal menu bar):
   Here, you can change the language or show the contact address.

2. Navigation area (left window pane):
   You will receive information about the selected product in the detail area if you click on a menu here.

3. Detail area (right window pane):
   Here, you can find product information and a navigational link to install the selected product, open a manual in PDF format, or open a third-party manufacturer’s website.

Selecting the language

Click the button "English" or "German" in the horizontal menu bar to change the interface language of the COMOS Setup browser to German or English.

Your selection is valid for the following points:

- Setup language of all components (except: only English for TIFF printer setup).
  Note: The selected language is binding for some components and in this case can only be changed by a new installation.

- User interface of COMOS: You can customize the language of the user interface after the installation.

Alternatively, a message window may pop up. Confirm with the "Yes" button.
8.5.3 Installing the COMOS portfolio

Requirement

The Setup browser has been started. See also chapter COMOS Setup browser: Start window (Page 71).

Procedure

Select a main product under "Content of the CD" in the "Main products" menu. Then, click on the corresponding link in the details area:

- "COMOS"
  - "Install COMOS"
- "COMOS 3D Integration (add-on installations)"
  - "Install PDMS Integration"
  - "Install Plant Modeler"
- "COMOS Enterprise Server"
  - "Install COMOS Enterprise Server"
- "COMOS Walkinside"
  - "Installing COMOS Walkinside Integration"
  - "Installing Walkinside Batch Assignment"

You must install a dongle driver when using a dongle: See also chapter Installing the dongle driver (Page 91).

Important note for Windows 7 and Windows Server

Under the following Microsoft operating systems the installation of the main product is not started directly via the installation link in the HTML interface of the CD Browser:

- Windows 7

Proceed instead as described in section Important note for Windows 7 and Windows Server (Page 61).

See also

Welcome screen from the InstallShield Wizard (Page 74)
8.5.4 Installing COMOS

8.5.4.1 Welcome screen from the InstallShield Wizard

In the "InstallShield Wizard" window, click the "Next >" button.

See also

Conditions of the license instructions (Page 74)

8.5.4.2 Conditions of the license instructions

To proceed with the installation, mark the "I accept the terms of the license agreement" option and click the "Next >" button.

Click the "Print" button to print the license agreement.

See also

Target folder for the COMOS installation (Page 74)

8.5.4.3 Target folder for the COMOS installation

The installation wizard recommends a target folder in the "InstallShield Wizard" window.

Adapting the target folder

1. To use another folder instead, click the "Change" button; otherwise click the "Next >" button.
2. If you want to change the target folder, another window appears.
3. Click the "Create new folder" button to create a new directory. Assign a suitable name to the new folder.
4. Click "OK" to confirm.

The selected folder has to be empty; otherwise, a window with the following message is displayed: "The selected directory is not empty! Please select an empty directory."

You cannot change the target folder after the installation.

See also

Select the source folder for the service pack (Page 75)
8.5.4.4 Select the source folder for the service pack

In the next window, select the service pack that is executed with the COMOS installation.

- To change the source folder where the service pack is included, click on the "Change ..." button. Select the source folder and click the "OK" button, then the "Next >" button. The directory with the service pack that is to be installed may not be located in the COMOS program directory.

- The field can also remain blank. In this case you install a service pack via the Update Center later. See also section Specifying the update path manually using the dialog window (Page 94). The Update Center is located under "Start > Programs > Comos > <Version Number>".

COMOS cannot run without a service pack installed.

See also
Defining the licensing (Page 75)

8.5.4.5 Defining the licensing

In the next window you select the licensing mode. There are two possibilities.

"License server": Network license

Click the "Next >" button to confirm.

The next window displays the name of the license server / port that may have already been set in an older version. As default setting the full name of the COMOS LS Server "ComosLizenzServer" appears in the "Name" field and standard port "27011" in the "Port" field. Both fields are editable. To proceed, click the "Next >" button.

"License file": Single seat license

This option copies a license file with a single seat license to your hard drive. You need a dongle for this, as well as the corresponding dongle driver. You must install this driver if it is not already installed. See also section Installing the dongle driver (Page 91).

Click the "Next >" button to confirm.

In the next window select your license file with the "..." button; otherwise you cannot proceed with the installation.

Once you have selected the license file, the next window opens informing you that you have successfully copied the license file to the specified path. Click "OK" to confirm.

The following installation steps apply for both licensing types.

See also
Starting and completing the installation (Page 76)
8.5.4.6 Starting and completing the installation

Click the "Install" button. This process may take a few minutes.
Click the "Finish" button in the next window.

8.5.4.7 Covered part modules

The client installation basically covers the following components:

- Help
- COMOS program files
  Only available if you have selected an update in the Select the source folder for the service pack (Page 75) section.
- COMOS Update Center
  The path is: "<Installation directory>\updatecenter\Comos Update Center 4.exe". In the course of the COMOS installation, you specify the path from which the COMOS Update Center is to obtain its update source files. You can also enter this information later. For information on using the COMOS Update Center, see also section Installing COMOS updates (Page 93).
- Config file (optional) or license file (optional)
- Runtime files
- Microsoft .NET Framework 4
- Microsoft Visual C++ 2010 Redistributable Package (x86)

Which of the components is installed depends on the user inputs and the PC.

All components, except the hardlock driver, are installed in the background. This means that after starting the installation the user does not have to make any further entries. The installation process is only visible via the status bar. The hardlock driver has its own installation routine, which you need to confirm.

8.5.4.8 Changes on the PC

This section only describes the changes regarding the installation of the COMOS Client. For example, it does not cover the installation of the printer drivers.

Depending on the selected components, the following changes are made to your system configuration:

- The COMOS start symbols are added to a program group, standard recommendation: "Start > Programs > Comos > <Version Number>".
- The installation directory for COMOS is created: "<Program directory>\Comos\<Version Name>".
- In the COMOS installation folder, a "Help" subfolder is created which in turn contains more folders and files.
- The COMOS Update Center is installed. See also chapter Installing COMOS updates (Page 93).
If you install the dongle software locally, the files are copied to the "Windows\System32" directory. The new "Hardlock Device Driver" entry can then be found in the "Properties of software" window. You can use this entry to automatically remove the Hardlock driver.

Fonts folder
Installation of following fonts, if not yet available:
"nina.ttf" = "Nina Standard"
"ninab.ttf" = "Nina Bold"

Runtime components are copied to "Windows\System32".

Microsoft .NET Framework 4/.NET Framework 4.5
Microsoft Visual C++ 2010 Redistributable Package (x86)

8.5.4.9 Customization

Plugins / Manifests
If you create customized settings under the "\bin-path", only use the following folder and files. These are not overwritten by updates.

- File: "ComosCustomize.manifest"
  Automatically created during the complete version setup.

- Folder: "Custom"
  Create this folder manually.
  The folder name "Custom" has to be spelled exactly this way!

Basic information concerning manifests
Manifest files are used to describe COM components and ComVisible assemblies so that components do not have to be registered. All manifest files can reference other manifest files.

The syntax for COM components differs from that for ComVisible assemblies. The manifests for assemblies can be embedded in the assembly or created separately as files.

Manifest files can be manually created with Microsoft tools, for example "RegAsm.exe", "MT.exe" or with tools from third-party vendors.

GDI Resources

Registry entries
Windows only has limited resources for the graphical display of interfaces ("GDI resources"). If several graphic-demanding applications are started at the same time, Windows may become overloaded. If you overload your PC, the monitor will no longer be correctly refreshed.

However, mouse clicks are still executed.
COMOS display a message regarding limited GDI resources well in advance. You specify yourself in the registry of the computer when this warning appears:

- "HKEY_CURRENT_USER > Software > INNOTEC > COMOS > ComosExe > Comos"
  Value: "MaxGDIResourceCount"

This value only has an effect on the limit specifying when the message box containing the warning is displayed.

In the event of shortages the administrator should check if more GDI resources can be provided. The system side limit for GDI resources are set as follows:

- "HKEY_LOCAL_MACHINE > SOFTWARE > Microsoft > Windows NT >"
- "CurrentVersion > Windows"
- "GDIProcessHandleQuota"
- "UserProcessHandleQuota"
  "Default value: 12,000"

Windows XP: theoretical maximum value is 18,000.
As of Windows XP SP3: 64,000 possible, approx. 12,000 can be effectively used.

**GDI objects per GB of RAM**

The GDI resources are directly dependent on the available memory.

If you set a higher value, it will be reset to 10,000.

The value of the two entries GDIProcessHandleQuota and UserProcessHandleQuota has to be the same. You need to reboot after making the changes.

Avoid opening too many report or tproperties windows at the same time.

**Unloading dynamic icons**

Dynamic icons are the icons which have been assigned to the objects via their base objects. They are loaded when necessary and use up many GDI resources. Windows controls the screen with the GDI resources. COMOS informs you if your GDI resources are almost used up.

If necessary, unload the dynamic icons to release GDI resources with the following command:

- Context menu in the Navigator: "Unload all dynamic icons"

**See also**

[Troubleshooting during excessive GDI resource consumption with COMOS](Page 120)
8.5.5 Uninstalling COMOS

There are two ways to uninstall COMOS:

- By means of the usual uninstall process:
  - In the Windows Start menu, select "Start > Control Panel > Add or Remove Programs".
  - Select the COMOS version. Click the "Remove" button. A prompt is displayed again whether you really want to remove COMOS <Version Number>. Confirm with the "Yes" button.

- By means of the Setup browser.
  - Select the subdirectory of the corresponding product in the directory "...\Setup browser \Software", for example:
    To uninstall COMOS: "...\Comos Main\Comos"
    To uninstall Remote License Service: "...\License Products \ComosRemoteLicenseService"
  - Run the "setup.exe" file. The window with the language selection opens.
  - Select the desired language and confirm with the "OK" button.
  - Click "Next". The window for removing the program is displayed. Confirm with the "Remove" button. To exit the wizard, confirm with the "Finish" button.

For a complete uninstallation of COMOS, you have to manually delete the program directory and the files it contains.

8.5.6 Installing the COMOS database

The COMOS database contains all system objects and libraries required for COMOS. The database provided here is an Access database.

Requirement

- Before you unpack the database, check to make sure that the current COMOS version is installed. If it is not, you will receive a prompt.

- The Setup browser is open. See also chapter [COMOS Setup browser: Start window](Page 71).

Procedure

1. Select the menu "COMOS database > COMOS iDB".
2. Click on the link in the details area to extract the data on to your PC.

To use the database productively you must copy the Access database to your MS SQL database or Oracle database. Test your databases before using them productively.

Additional information about installing and managing databases can be found in the "COMOS Platform Administration" manual, keyword "Integrating databases in COMOS and waiting".
Existing customer databases

If a database already exists, it should not be simply overwritten. This could create a fault-prone mix of the new and the old database.

Procedure:

- Delete the old database manually and write the new database to the folder that is now empty
- If you want to keep the complete old database, select a different installation folder for the new database.

Changes on the PC

The following folders are created during the database installation:

- "Database<Version Number>" folder
  This folder contains:
  - Reports (example projects / copy templates)
  - Report templates
  - Icons
  - Other administrative files
- "Database<Version_Number>.mdb"

The database includes the current system project, a base object as well as an example project. If you do not copy the database, your administrator should check whether an import of the system project is required. Current COMOS versions use functionalities that can only be executed together with the current system project.

English is initially set as the database language. You can change the language. Open the database in COMOS and select a different language under project properties in the "Language" category.

8.5.7 Installing COMOS license products

8.5.7.1 Overview of COMOS License Management

COMOS is based on a client-client network, and for this reason all COMOS clients are technically equal. Every COMOS client can provide its own license (local license). Citrix solutions and similar work environments are excluded in this case. COMOS License Management (COMOS LM) is not required in a system of clients with local licenses.

COMOS License Management is absolutely required if central licenses are intended to be used.

COMOS License Management is a collection of software tools and workflows that are provided along with the central licenses for COMOS. They also support mixed systems including local licenses.
The programs that are required for licensing, the registration of licenses, user administration, and all related tasks can be found in the "License products" menu of the COMOS setup browser.

**Requirement**

The Setup browser is open. See also section COMOS Setup browser: Start window (Page 71).

**Packages that can be installed in COMOS LM**

The following installation packages are available:

- **COMOS LS**
  The setup for COMOS LS includes the following components:
  - COMOS LSService
  - COMOS LSProcess
  - COMOS LSMonitor (integrated application)

- **COMOS License User Manager**

- **COMOS LSMonitor (single application)**

- **COMOS Remote License Supplier**

All packages that can be installed have their own version number.

**Important note for Windows 7 and Windows Server**

Under the following Microsoft operating systems the installation of these programs is not started directly via the installation link in the HTML interface of the Setup browser:

- Windows 7

Proceed instead as described in section Important note for Windows 7 and Windows Server (Page 61).

**Additional information**

You can find additional information on this topic in the "COMOS Platform Administration" manual, keyword COMOS License Management".

**See also**

- Installing COMOS LS (Page 82)
- Installing the COMOS Remote License Supplier (Page 82)
- Installing the COMOS License User Manager (Page 82)
8.5.7.2 Installing COMOS LS

Requirement

- You are familiar with COMOS License Management.
  See chapter Overview of COMOS License Management (Page 80).

Procedure

1. Select the menu "License products > COMOS License Server (COMOS LS)".
2. Click the "Install COMOS LS" link. You can find additional information in the "COMOS Platform Administration" manual, keywords "Manage licenses with COMOS LS" and "Using the COMOS LS Monitor".
3. Click on the link "Install COMOS LS Monitor" to install only the license server monitor. You must install a dongle driver when using a dongle: See also section Installing the dongle driver (Page 91).

See also

Interrupted communication (Page 108)

8.5.7.3 Installing the COMOS Remote License Supplier

Requirement

- You are familiar with COMOS License Management.
  See chapter Overview of COMOS License Management (Page 80).

Procedure

1. Select the menu "License products > COMOS Remote License Supplier".
2. Click the "Install COMOS Remote License Supplier" link.
   You can find additional information on this topic in the "COMOS Platform Administration" manual under the keyword "Using the COMOS Remote License Supplier".

8.5.7.4 Installing the COMOS License User Manager

Requirement

- You are familiar with COMOS License Management.
  See chapter Overview of COMOS License Management (Page 80).
Procedure

1. Select the menu "License products > COMOS License User Manager".
2. Click the "Install COMOS License User Manager" link.

You can find additional information on this topic can be found in the "COMOS Platform Administration" manual, keyword "Using the COMOS License User Manager".

8.5.8 Installing COMOS add-on programs

8.5.8.1 Overview of the COMOS add-on programs

The following add-on programs are located in the "Add-on programs" menu:

- "COMOS DocumentView"
- "COMOS TIFF Printer"
- "COMOS TIFF server"
- "Teamcenter FCC"
- "SIMATIC XML Transfer"

Requirement

The Setup browser is open. See also chapter COMOS Setup browser: Start window (Page 71).

Important note for Windows 7 and Windows Server

Under the following Microsoft operating systems the installation of these programs is not started directly via the installation link in the HTML interface of the Setup browser:

- Windows 7

Proceed instead as described in section Important note for Windows 7 and Windows Server (Page 61).

See also

- "COMOS DocumentView" (Page 84)
- Installing the "COMOS TIFF Printer" (Page 84)
- Installing "COMOS TIFF server" (Page 87)
- "Teamcenter FCC" (Page 88)
- "SIMATIC XML Transfer" (Page 89)
8.5.8.2 "COMOS DocumentView"

COMOS DocumentView allows you to link COMOS to a Sharepoint.

Procedure

1. Select the menu "Add-on programs > COMOS DocumentView".
2. Click on the link.
3. Copy the wsp file. This is a solution package.
4. The installation of solution packages is described in your Sharepoint documentation.

8.5.8.3 TIFF-printer limitation

You cannot use the COMOS TIFF PRINTER with:

- Windows 7 (32-bit and 64-bit)
- Windows Server 2008 R2 and later

Instead, configure your Revision printer using the file "HARP.ini".

8.5.8.4 Installing the "COMOS TIFF Printer"

General information regarding the printer driver

Printer driver for the revision archive (revision printer)

COMOS offers the option to revise documents. A special printer driver is installed on your PC. COMOS supports TIFF or PDF as file formats. There are a variety of printer drivers that can produce TIFF, and there are printer drivers that can produce PDF. The result will differ slightly depending on the printer driver.

COMOS has a fixed list of supported printer drivers, some of which are not included in the scope of delivery. You need to purchase these drivers separately.

COMOS-specific instances of the printer drivers

If a printer driver is not only used by COMOS but also by applications from other vendors, conflicts may occur. For example, a different software might require completely different printer driver settings.

In such cases, you can configure different printer driver instances:

1. Open "Start > Control Panel > Printers and Faxes"
2. Duplicate the desired printer driver.
3. Configure the copy for the COMOS requirements.

4. Rename the copy as follows and note the spaces:
   'Comos' + <PrinterName>

Effect: COMOS and other applications do not have to share one and the same printer driver; users can still use their regular printer drivers for other applications.

Currently, you cannot create a second instance for the TIFF printer driver that is included in the COMOS scope of delivery.

Licensing

Fully executable version, included in the COMOS product package. However, no support is provided.

Driver versions

| as of COMOS 9.0: | Printer Driver 10.24 |
---|---|

Due to technical reasons it is possible that the output of the different versions can vary marginally.

Installation

Procedure

1. Select the menu "Add-on programs > COMOS TIFF Printer".
2. Click on the link in the detail area.

If required: Uninstalling an existing version

Existing versions are always deleted first when you start the installation routine for the Tiff printer driver. You must confirm this with "OK".

During the uninstallation routine there is a callback asking if shared data should also be deleted. Consult your system administrator to determine the correct option here.

After the deinstallation there is callback stating a "successful installation". At the completion of the installation there is a prompt to restart the computer. Follow this prompt, otherwise the new TIFF printer might not be installed without errors.

If the installation does not automatically continue after rebooting the computer, click the "Install COMOS TIFF Printer" link once again.

Installing the new version

The InstallShield Wizard starts when you click the "Install COMOS TIFF Printer" button.

The interface language is always English.

Click "Finish" to complete the installation.
Settings for the printer driver

To set up a printer driver for a COMOS revision printer, open the properties of the printer driver:

- "Start > Control Panel > Printers and Faxes > "<Printer driver>" > Printer Settings..."

If you make the settings in COMOS and you have the required rights, the settings from the "Properties" of the printer are permanently overwritten without another prompt.

Print settings

"Start > Control Panel > Printers and Faxes > "<Printer driver>" > "Printer Settings..."

"Device Settings" tab

You can control the paper size by means of a script option in COMOS. Otherwise the settings that were made here are applied.

The paper alignment is automatically conducted by COMOS.

The remaining settings in this tab can be set freely.

The file size increases with a higher resolution.

"File Formats" tab

Requirement: One of the TIFF formats is selected.

Different "file format" settings generate different results.

Example: If the setting "TIFF Group 4" is selected, the output has a displacement of 0.4 mm in contrast to "TIFF Group 3.1 Dimension".

"Options":

- "Create Multipage Image" option: Must be activated.
- "Disable Image" option: Must be disabled.

"Filename Generation" tab

- "Name Generation Method" list: Must be set to "Use the document name".
- "Filename" field, "Keep existing files" option: Must be disabled.

You need full access for the "Output Directory" field.

- "Output Directory" field: If no directory is specified, the temp directory of the user is automatically set as the output directory.
  With Citrix: Each user needs a separate "Output Directory".

Remaining tabs

Keep the default settings.
Printer name

Standard name: "Comos Tiff"
No second instance can be created for the TIFF printer driver.

Changes on the PC

The printer folder for the "Comos Tiff" printer is added in the "Control Panel". The corresponding printer drivers are copied to the "\WinNT\System32" folder and a folder for the printer sample files is created.

TIFF viewer

TIFF is one of the possible archiving formats for COMOS revisions. COMOS has a built-in TIFF viewer. It is therefore unnecessary to install an additional TIFF viewer if TIFF is selected as the revision format.

Additional information on this topic can be found in the "COMOS Platform Operation" manual, keyword "Revising".

Behavior during a COMOS uninstallation

When you uninstall COMOS, this printer driver is not removed from your system. To uninstall the driver, remove the driver printer by means of the control panel.

8.5.8.5 Installing "COMOS TIFF server"

Licensing

Fully executable version, included in the COMOS product package. However, no support is provided.

Driver versions

<table>
<thead>
<tr>
<th>Starting from COMOS 8.1.4:</th>
<th>Printer Driver 9.02</th>
</tr>
</thead>
</table>

The version number of the "Tiff" printer driver and that of the "Tiff (Server)" printer driver are completely independent.

Installation

1. Select the menu "Add-on programs > COMOS TIFF Server".
2. Click on the link in the detail area.

You need a special driver if you want to use a TIFF printer driver on a Citrix server.

Available for:

- Windows XP SP3
If no terminal server is installed on your PC, the installation of the TIFF printer driver is canceled.
If the terminal server is available, installation is performed.

Comparison of the two TIFF printer drivers

These are two different developments with different results.
The printer driver "Tiff (Server)", for example, produces colored files and also has other default settings in the properties.
Switching from one driver to another can, therefore, only take place after conducting thorough tests with test files. The generated revision files will definitely differ from each other.

Control/Configuration

The server variant is basically configured like the local TIFF printer driver. There are the differences:

"File Formats" tab

- "File format" list
  "TIFF Lempel-Ziv&Welch"
- "Color depth" list
  The color depth is only available for this server variant and can only be set there since the local TIFF printer driver cannot print in color.

8.5.8.6 "Teamcenter FCC"

1. Select the menu "Add-on programs > Teamcenter FCC".
2. Click on the link.
3. Follow the instructions in the InstallShield Wizard.

The Teamcenter File Client Cache (FCC) gives you access to the data of a Teamcenter server.
You also need a license for the COMOS interface to the Teamcenter for communication between COMOS and Teamcenter.
Additional information on this topic can be found in the "COMOS Platform Interfaces" manual, keyword "COMOS Teamcenter Interface".
8.5.8.7 Installing the COMOS revision printer (HARP)

Aim

The freely configurable revision printer (HARP) technically supports a large number of customer-specific revision processes. The revision printer works in two steps:

1. Creating a PostScript file
2. Conversion of the PostScript file into PDF

The standard configuration that has been tested and maintained by Siemens support can be installed in the Setup browser.

Procedure

To install this standard configuration, follow these steps:

1. Select the menu "License products > License Management (COMOS LS)".
2. Click the "Install COMOS Revision Printer (HARP)" link.

Additional information on this topic can be found in the "COMOS Platform Administration" manual under the keyword "Revision archive "Configuring freely configurable revision printers".

8.5.8.8 "SIMATIC XML Transfer"

1. Select the menu "Add-on programs > SIMATIC XML Transfer".
2. Click the "SIMATIC XML transfer" link.

Used for exchange with PCS 7. Includes the component "AI COMPONENTS" as well as the menu entries for an XML import and export in PCS 7.

STEP 7 (part of SIMATIC PCS 7) is a mandatory requirement for installation and use.

8.5.9 Installing third-party programs

8.5.9.1 Overview of the COMOS third party programs

The "Third Party Programs" menu contains links to third-party programs that are required for working with COMOS:

- "Adobe Reader"
- "pdfFactory Pro"
- "Dongle driver"

Requirement

The Setup browser is open. See also chapter COMOS Setup browser: Start window (Page 71).
8.5.9.2 Install Adobe Reader

 Licensing

 The Adobe Reader is free of charge.

 Version

 Adobe Reader X

 Installation

 1. Select the menu "Third Party Programs > Adobe Reader".
 2. Click on the link.

 The Adobe website opens from which you can download Adobe Reader and install it.

 Specific points relating to use

 PDF is one of the possible archiving formats for COMOS revisions.

 A PDF viewer must be installed to open and read revision files in "PDF" file format.

 A software program that creates files of the "PDF" type must be installed to create and release PDF revision files. This software can be purchased from the respective manufacturer.

 8.5.9.3 Install pdfFactory Pro

 Licensing

 You can download a free limited trial version or purchase a full version.

 Version

 Version 4.x: The necessary functions for COMOS are enabled. Any additional functions of the pdfFactory, as well as printing and revising via the COMOS Enterprise Server, are not enabled.
Installation

To create a "PDF" type file a corresponding printer driver must be installed on the PC. This software is only required on PCs releasing a revision. A PDF is only written at this time.

1. Select the menu "Third Party Programs > pdfFactory pro".
2. Click on the link.

The pdfFactory website opens from which you can download pdfFactory and install it.

Specific points relating to use

- "pdfFactory" or
- "pdfFactory Pro"

Full access right: "Printing settings...", "Settings" tab > "Folder locations" list

8.5.9.4 Installing the dongle driver

The protective adapter software (HASP4 dongle) is necessary for error-free operation of the protective adapter on the USB port. The dongle driver is only required for a single user COMOS license. Install dongle drivers and dongles only on the server of the license manager for network licenses.

Outdated dongle drivers could lead to a system crash when used in conjunction with Windows 7. Check that you are using the right driver for your operating system.

Procedure

You must install a dongle driver when using a dongle:

1. Select the menu "Third Party Programs > Dongle driver".
2. Click on the link.

A website opens from which you can download the driver and install it.

The dongle driver is a prerequisite for using the "Dongle.exe" tool.

8.5.10 Installing COMOS documentation

8.5.10.1 Overview of the COMOS documentation

Relevant documents for the installation can be found in the "Documentation" menu. The documents are available in PDF format. To read them you need a PDF reader that is compatible with PDF 1.7 (ISO32000-1:2008 PDF).

In addition you have access to the entire COMOS documentation in the details area of the "Documentation" menu. Click on the link "To customer documentation" for this purpose.
Electronic manuals and information on COMOS after installation

A help directory is installed on your computer with the COMOS installation: "<COMOS installation directory>/Help/help_iDB"

The following documentation is available in the help directory:

- "COMOS help system" (collection of manuals)
- "COMOS 10.1 - What's New?"
- "COMOS 10.1 - Readme"

After COMOS has been installed, you can open the complete help as follows:

1. Starting COMOS
2. "Help > COMOS help system" menu bar

If references are made to other manuals in the documentation, these manuals are also available via the "COMOS help system". To navigate to these manuals, go to the "Content" tab in the COMOS help system and open the table of contents until you can see the individual manuals.

See also

- "Readme with installation instructions" (Page 92)
- "What's New?" (Page 92)
- "Frequently Asked Questions" (Page 93)
- Known Issues (Page 92)

8.5.10.2 "What's New?"

Click the "What's New?" link.
A PDF file opens.

8.5.10.3 "Readme with installation instructions"

Click the "COMOS Readme" link.
A PDF file opens.

8.5.10.4 Known Issues

The Known Issues are now part of the readme.

See also

Known Issues (Page 113)
8.5.10.5 "Frequently Asked Questions"
Click on the link "COMOS Frequently Asked Questions". A PDF file opens.

8.6 Installing COMOS updates

8.6.1 Overview
Overview of the COMOS Update Center:
- The COMOS Update Center is a mandatory component of the installation of the COMOS basic version.
- The COMOS Update Center installs COMOS updates. The latest update contains all changes made to the previous update of this version.
- User interface language of the COMOS Update Center
  The installation language determines the user interface language of the COMOS Update Center.
  A subsequent change is only possible by changing the registry:
  `HKEY_LOCAL_MACHINE > SOFTWARE > Wow6432Node > INNOTEC > COMOS,entry language`

Once you have installed a basic version of COMOS, you can call the COMOS Update Center as a dialog window. To do this, open the program "Start > Programs > COMOS > 10.1 > UpdateCenter".

8.6.2 Call options
You can call the COMOS Update Center as a dialog window, as a console window, or in Silent mode.

If you initiate the call as a console window or in Silent mode, the application needs to be called with all the required parameters. The call is carried out without any operator actions taking place and the program is exited automatically.

Using the call options
- As part of a basic COMOS installation, the COMOS Update Center is called in the form of a console window.
- The COMOS Update Center is called as dialog window for updates and subversions.
8.6.3 Installation

The COMOS Update Center is installed during the COMOS Client installation. The COMOS Update Center is considered a mandatory component: The installation is performed in the background without a further prompt.

The path is "<COMOS_Installation_Directory\updatecenter\Comos Update Center 4.exe". However, in the course of the COMOS installation, you specify the path from which the COMOS Update Center should obtain its update source files. You can also enter this information later.

8.6.4 System Environment/Further Conditions

- As of COMOS version 9.0, you no longer have to be logged in as an administrator in the Update Center.
  You require the following rights:
  - Full access: No
  - Edit: Yes
  - Read, execute: Yes
  - List folder content: Yes
  - Read: Yes
  - Write: Yes
  - Special rights: No
  Usually the Windows group of the main users has these rights.

- The Update Center requires that none of the files in the COMOS installation path can be accessed. This means that COMOS has to be closed. No program in the "Bin" folder may be running, including DBMon from the "Bin" folder. No help file or text file from this folder may be open.

- The update must not be stored in the COMOS program directory.

8.6.5 "ServicePack.xml"

Each service pack and DocuPack is associated with a "ServicePack.xml" file. This file is stored there and identifies the service pack concerned. Even basic installations contain a service pack for the basic version and, therefore, file "ServicePack.xml".

The file is important for identifying and controlling installations and updates. If you contact the support department, you will often find that they require this file in order to extract information from it.

8.6.6 Specifying the update path manually using the dialog window

You can install specific updates by calling the required location via the update window. You need to exit COMOS before doing this.
If you have not specified an update path as described in section Select the source folder for the service pack (Page 75), you can do this manually:

"Start > Programs > Comos > 10.1 > UpdateCenter.

Click the "Select Service Pack" button. There are two available options:

1. Select an unzipped service pack
   Select a unzipped service pack from one of the directories and confirm with the "OK" button. The selected service pack will be checked. The current status can be seen in the window of the COMOS Update Center at any time.
   To install the service pack, click the "Update" button. Once it has been successfully installed, a window confirming this is displayed.
   Click the "Quit Application" button to exit the COMOS Update Center.

2. Select a ZIP file
   Select a directory in which a compressed version of the "ZIP" file of the service pack is located. Click "OK" to continue.
   An additional button, "Unzip Archive", is displayed at the top right of the COMOS Update Center window. Click this button. The service pack is now unzipped and verified.
   To install the service pack, click the "Update" button. Once it has been successfully installed, a window confirming this is displayed.
   Click the "Quit Application" button to exit the COMOS Update Center.

Information messages

A message appears if you select an old service pack and, therefore, a smaller service pack number. You will be prompted if you want to overwrite the service pack. Confirm with the "OK" button or cancel with the "Cancel" button. The same procedure applies if the service pack has already been installed.

8.6.7 Parameter-controlled update in Silent mode / Console mode

You can start the COMOS Update Center for a parameter-controlled update without a Windows interface. To do this, the software needs the program call to transfer the service pack as a parameter. In Console mode, you can view the progress of the service pack installation process. This may take a few minutes. The program is exited automatically. In Silent mode, you cannot view the progress of the installation process or see the program being exited.

Example of a call in Console mode:
"<COMOS installation folder>\updatecenter\Comos Update Center 4.exe" /COMOSTYPE:101 /CONSOLE /PATH:"X:\CIS\SERVICE_PACKS\V101_Upd_03.zip"

Example of a call in Silent mode:
"<COMOS installation folder>\updatecenter\Comos Update Center 4.exe" /COMOSTYPE:101 /CONSOLE /PATH:"X:\CIS\SERVICE_PACKS\V101_Upd_03.zip"

Both examples install service pack 03 from the "X:Cis\Service_packs" directory.

It is important to set parameters with spaces in " " (quotation marks), as well as the path to the EXE file for the COMOS Update Center.
The parameter "/COMOSTYPE:xx" determines the COMOS target version. If you work with several parallel versions, this parameter determines which version is updated.

The value "xx" stands for the COMOS version.

For example:
- "90" for COMOS 9.0
- "91" for COMOS 9.1
- "92" for COMOS 9.2
- "100" for COMOS 10.0
- "101" for COMOS 10.1

If the parameter is missing, "90" is assumed.

8.6.8 Installing subversions

Objective

Subversions are functional extensions of a COMOS version. Always consult your customer representative concerning the use of subversions, since such packages only provide narrowly defined functionality. By contrast, a new version of COMOS incorporates a general upgrade of COMOS, with all interrelated functionalities.

A subversion is not a completely new version of COMOS. In special cases a subversion can be a handy extension of an existing version.

Formal requirements

Subversions behave just like service packs:

- Search the COMOS Update Center for the folder with the subversion and start the installation.

- Use either the ZIP file or the extracted files from the ZIP file. If both are present, then: The extracted files have priority over the ZIP file.

- Service packs and subversions should not be located in the same folder.

Do not uninstall the subversions. Since these provide additional functions, the engineering data is changed. COMOS may not be able to process data correctly without the subversions.

If you have any doubt, you should test the subversion first using test data before working with the actual engineering data.
8.7 Parameter-aided installation of COMOS

8.7.1 General

You can also control the setup of COMOS via command line parameters. See section "Setup.exe_parameter.txt" (Page 97).

- One of the options is to start the internal built-in MSI Installer from Microsoft. To do so, use the "/v" option. See specifically section Passing parameters to the .msi file incorporated in "Setup.exe" (Page 98) for more on this.
  - If you use the "/v" option, all possibilities offered by the MSI Installer are available to you. See section "MSIDatenbank_Parameter.txt" (Page 101) for more on this.

8.7.2 "Setup.exe_parameter.txt"

8.7.2.1 Command line parameters for "Setup.exe"

Copyright

(C) InstallShield

Parameter

Similar to a compiled "MSI" type file, "Setup.exe" can accept a limited set of command line parameters. You can use these parameters to specify the language to be used during your setup and if "Setup.exe" should run in Silent mode. You can also pass parameters to the incorporated "MSI" type file via "Setup.exe".

The "Setup.exe" file accepts the in the following described command line options:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;/v&quot;</td>
<td>MSI command line parameter</td>
</tr>
<tr>
<td>&quot;/s&quot;</td>
<td>Silent mode</td>
</tr>
<tr>
<td>&quot;/l&quot;</td>
<td>Setup language</td>
</tr>
<tr>
<td>&quot;/p&quot;</td>
<td>Password mode</td>
</tr>
<tr>
<td>&quot;/a&quot;</td>
<td>Administrative installation</td>
</tr>
<tr>
<td>&quot;/j&quot;</td>
<td>Advertise mode</td>
</tr>
<tr>
<td>&quot;/x&quot;</td>
<td>Uninstall mode</td>
</tr>
<tr>
<td>&quot;/r&quot;</td>
<td>Repair mode</td>
</tr>
<tr>
<td>&quot;/w&quot;</td>
<td>Wait</td>
</tr>
</tbody>
</table>
8.7.2.2 Passing parameters to the .msi file incorporated in "Setup.exe"

If the "Setup.exe" file is part of your setup, you have to pass command line parameters to the "MSI" type package incorporated in "Setup.exe". Arguments are passed to the "MSI" type file using the "/v" option. By using this option, you can list all supported parameters that are passed to the "Msiexec.exe" file.

For example, you could use the "Transforms" command:

"Setup.exe /v"TRANSFORMS="C:\Transforms\My Transform.mst"

For passing over parameters there are some special formatting rules you have to regard. First you have to set a backslash (\) prior to every quotation mark which is inside already existing quotation marks.

The command line stated above, for example, contains the following:

"/vTRANSFORMS=\"C:\Transforms\My Transform.mst\""

You have to use the quotation marks since the path to transform is a long one. Since you have to set the entire argument in quotation marks the command line instruction might fail if you don’t set a backward slash prior to all internal quotation marks.

Another formatting rule stipulates that no spaces are allowed between the command line option "/v" and the arguments passed.

If you pass over multiple parameters with the "/v" option, you have to separate them with a space, for example:

"Setup.exe /v"TRANSFORMS=\"C:\Transforms\MyTransforms.mst\" /qn"

This command applies a transform and executes the setup in silent mode.

8.7.2.3 Running "Setup.exe" in Silent mode

If you do not want to display a status bar when the "Setup.exe" file is launched, use the "/s" command line parameter.

Example

The "Setup.exe /s" command launches the "Setup.exe" file, but no user interface is displayed. If you also want MSI setup to be run in Silent mode, you have to pass the "/qn" command line parameter using the "/v" parameter via the "Setup.exe" file, e.g. "Setup.exe /s /v/qn".

If you have included the "Select Setup Language" dialog box to give the end user the opportunity to select a language for running the setup, this dialog window will not be displayed.

Instead, the setup is carried out in the default language of the target computer. If the target computer's language is not part of the available languages that are shipped, setup is conducted in the default language, normally English. You can use the "/l" command line parameter to specify a certain language.

If your setup is password-protected, you also have to pass the "/p" parameter.
8.7.2.4 Specifying the setup language from the command line

If you include multiple languages in your setup, InstallShield creates the setup in your default language and creates so-called transforms for each embedded language. If you want to have the setup language selected based on the location of the target computer, a transform is performed according to the language area/region of the target system. Since these languages are applied in the form of a transform, you can specify the language via the command line of the "Setup.exe" file using the "/v" option.

8.7.2.5 Disadvantages of using the "/v" parameter

Using the "/v" parameter to specify the language has two major disadvantages. These disadvantages can be avoided by using the "/l" parameter.

The first disadvantage is that the language transform that you request is added to the language transform that is applied by the search for the language area/region. As an example, you could create a setup in two languages, English and German, and create it in a way that the setup is executed in German if the country settings in the target system are set to German. If you want the setup to always be run in German and use the "/v" command line parameter to apply the German transform, the "MSI" type file gets the following command:

"TRANSFORMS=1031.mst;1031.mst"

However, if you use the "/l" parameter instead, the original transform is not applied and the "MSI" type file gets the following command:

"TRANSFORMS=1031.mst"

From a functional point of view it makes no difference which parameter you use. If you use a parameter that applies the transform twice, the time the setup takes for the start is doubled.

The second disadvantage of using the "/v" parameter is that the "Setup.exe" file is not run in the correct language. Only by using the "/l" parameter you can ensure that the "Setup.exe" file will be run in the language that you specified in the command line.

8.7.2.6 Using the parameter "/l"

Instead of stating a transform you have to state a decimal language ID. The command for German, for example, would be "Setup.exe /l1031".

8.7.2.7 Stating a password from the command line

You can use the "/p" parameter to define a password for a password-protected setup. If you execute a password-protected setup in silent mode, you have to enter the password from the command line, otherwise the installation would fail.

In order to execute a password-protected setup in silent mode, enter following command in the command line:

"Setup.exe /s /v/qn /p"Password""
8.7.2.8 Stating the installation mode from the command line

You can specify the mode for running your setup using the "/a" (Administration, "/j" (Advertise), "/x" (Uninstall mode) or "/f" (Repair) parameters. These options are described in detail in the following sections.

8.7.2.9 Administration

If you execute a setup in "Administration" mode you can install the setup on the network. In doing so you give everyone who has the appropriate rights the option to install the setup on their local computer. No further parameters are required for this option.

8.7.2.10 Advertise

"Advertised programs" is an installation mode upon request where features are not installed during the setup, but instead upon request from the installation program. If you start the "MsiExec.exe" file with the "/j <package> option, the components are offered on the computer of the end user but are not immediately installed. In most cases there is the possibility to offer the features in the User-defined setup dialog field.

8.7.2.11 Uninstallation

If you want to uninstall from the command line, you need to use the "/x" option, e.g. "Setup.exe /v/x". No further parameters are required.

8.7.2.12 Repair

Starting a setup in "Repair" mode ensures that the key file of every component is installed and undamaged. Starting a setup in "Repair" mode ensures that all your application data is available and undamaged. If the setup determines that a file is missing or damaged, it tries to solve the problem.

To start a setup in "Repair" mode from the command line, use the "/f" option.

8.7.2.13 Wait

Use this command line option if you want the "Setup.exe" file to wait until "MsiExec.exe" is completed before closing. Furthermore, the "/w" command returns all return codes generated by the "MsiExec.exe" file.

If you use the "/w" option in a batch file, you should use the Setup.exe command line argument "start /w" as a prefix. A correctly formatted example would be:

"start /w msiexec.exe /w /i readme.txt"

(C) Install Shield
8.7.3 "MSIDatenbank_Parameter.txt"

Copyright

(C) InstallShield

Purpose

The "MsiExec.exe" file is the executable Window Installer program which interprets installation packages and installation products on target systems.

Parameter

- "i/" <package> or <product code>
  Use this format to install the Othello product:
  "msiexec /i"
  "C:\WINNT\Profiles\author\My Documents\MySetups\Othello\Trial Version\Release
  \DiskImages\Disk1\Othello Beta.msi"
  Product code refers to the GUID, which is automatically generated in the "Product code" property of your product.

- "f/" [p|o|e|d|c|u|m|s|v] <package> or <product code>
  An installation with the "f/" option repairs or reinstalls missing or erroneous files.
  As an example use the following syntax in order to force a new installation of all files:
  "msiexec /fa"
  "C:\WINNT\Profiles\author\My Documents\MySetups\Othello\Trial Version\Release
  \DiskImages\Disk1\Othello Beta.msi"
  Along with the following flags:

<table>
<thead>
<tr>
<th>Flag</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>p</td>
<td>Installs a missing file</td>
</tr>
<tr>
<td>o</td>
<td>Reinstalls a file if it is missing or if an older version of the file exists on the system of the user</td>
</tr>
<tr>
<td>e</td>
<td>Reinstalls a file if it is missing or if an equivalent or older version of the file exists on the system of the user</td>
</tr>
<tr>
<td>c</td>
<td>Reinstalls a file if it is missing or if a stored checksum for the installed file does not match the value for the new file</td>
</tr>
<tr>
<td>a</td>
<td>Forces a new installation of all files</td>
</tr>
<tr>
<td>u or m</td>
<td>Overwrites all necessary user registry entries</td>
</tr>
<tr>
<td>s</td>
<td>Overwrites all existing links</td>
</tr>
<tr>
<td>v</td>
<td>Starts your application from the source and saves the local installation package in the cache memory</td>
</tr>
</tbody>
</table>
The "/a" option can be used by users with administrator rights to install products in the network.

The "/x" option or <product code>
A product is removed with the "/x" option.

"/j" [u|m] <package>
- "/j" [u|m] <package> /t <transform list>
- "/j" [u|m] <package> /g
- "/j" <language ID>
  If the "/j" <package> option is used, the components of your application are offered on the computer of the end user.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;u&quot;</td>
<td>Only offers components to the current user</td>
</tr>
<tr>
<td>&quot;m&quot;</td>
<td>Offers components to all users of the computer</td>
</tr>
<tr>
<td>&quot;g&quot;</td>
<td>Specifies the language ID</td>
</tr>
<tr>
<td>&quot;t&quot;</td>
<td>Applies a transform on the offered product</td>
</tr>
</tbody>
</table>

Transforms allow the synchronization of an application for different languages. If you update the German version of your product you can also update the English version of your product by using transform.

"/l" [i|w|e|a|r|u|c|m|p|v|+] <log file>
If option /l is used for creation purposes, the path of the protocol file is defined and the settings of the flags define which information should be included in the protocol file:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&quot;i&quot;</td>
<td>Logs status messages</td>
</tr>
<tr>
<td>&quot;w&quot;</td>
<td>Logs warnings that are not critical</td>
</tr>
<tr>
<td>&quot;e&quot;</td>
<td>Logs all error messages</td>
</tr>
<tr>
<td>&quot;a&quot;</td>
<td>Logs the start of action sequences</td>
</tr>
<tr>
<td>&quot;r&quot;</td>
<td>Logs action-specific records</td>
</tr>
<tr>
<td>&quot;u&quot;</td>
<td>Logs user requests</td>
</tr>
<tr>
<td>&quot;c&quot;</td>
<td>Logs the starting parameters of the user interface</td>
</tr>
<tr>
<td>&quot;m&quot;</td>
<td>Logs &quot;insufficient memory&quot; messages</td>
</tr>
<tr>
<td>&quot;p&quot;</td>
<td>Logs terminal settings</td>
</tr>
<tr>
<td>&quot;v&quot;</td>
<td>Logs detailed output when set</td>
</tr>
<tr>
<td>&quot;+&quot;</td>
<td>Appends an existing file</td>
</tr>
<tr>
<td>&quot;*&quot;</td>
<td>Placeholder character: You can use it to log all information (except the detailed output setting).</td>
</tr>
</tbody>
</table>

"/p" <patch package>
If the "/p" option is used, a patch is applied to an installed setup package. In order to apply a patch to an installed administrative image, combine these options with "/a" as follows:
"/p" <patch package> "/a" <package>

"/q" [n|b|r|f]
The "/q" option is used in connection with the following flags to specify the layer of the user interface:
"q" or "qn" | Create no user interface
---|---
"qb" | Creates a basic user interface

The following settings for the user interface display a modal dialog field at the end of the installation:

| "qr" | Displays a reduced user interface |
| "qf" | Displays the complete user interface |
| "qn+" | Displays no user interface |
| "qb+" | Displays a basic user interface |

- "/?" or "/h"
  Both commands display the copyright information for the Windows Installer.

- "/y"
  This command starts the "SelfRegModules"s action (for the self-registration of the modules) and opens the "SelfReg" table. Use this option if you need to acquire registry information that cannot be directly added to the "SelfReg" table with the "InstallShields Power Editor". Select "Power Editor" in the check list in order to edit the MSI tables in your .msi project file.

- "/z"
  This command starts the "SelfUnregModules" action with which the registration for modules in the "SelfReg" table can be revoked. This module is located in the "ActionText" table, which can be opened via the "Power Editor".

- TRANSFORMS
  Use the command line parameter TRANSFORMS to state all transforms which should be applied on your basic package. The command line used to call the transform function might look like this:
  "msiexec /i "C:\WINNT\Profiles\author\My Documents\MySetups\Your Project\Trial Version\My Release-1\DiskImages\Disk1\ProductName.msi" TRANSFORMS="New Transform 1.mst""
  Multiple transforms can be separated by using semicolons. Therefore, it is not recommended to use semicolons in the names of the files which are to be used for transform, since the Windows Installer cannot interpret them correctly.

- Properties
  All public properties can be set or changed from the command line. Public properties differ from private properties in the way that they always appear in capital letters. Example: "COMPANYNAME" is a public property.
  Use the following syntax to set a property via the command line: "PROPERTY = VALUE".
  If, therefore, you would want to change the value for "COMPANYNAME" you would have to enter the following:
  "msiexec /i "C:\WINNT\Profiles\author\My Documents\MySetups\Your Project Name\Trial Version\My Release-1\DiskImages\Disk1\ProductName.msi" COMPANYNAME = "InstallShield"

(C) Install Shield
8.7.4 Installation in silent mode

Example for the above options: You can install COMOS in such a way that no InstallShield user interface starts.

```
setup.exe /s /i1033 /v"INSTALLDIR=\"C:\PROGRAM FILES\COMOS\92\" LICENSESERVER=\"COMOSLICENSESERVER" UPDATEPATH=\"D:\Comos\Comos 9.2\Service Pack\" /L* \"c:\msilog.log\" /QN+"
```

Remove the line breaks from this example.

Ensure that you do not remove or add spaces by mistake.

Explanation:

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>/s</td>
<td>Silent mode</td>
</tr>
<tr>
<td>/i1031</td>
<td>Language, here: German. English would be /i1033.</td>
</tr>
<tr>
<td>/v...</td>
<td>A switch, that from here on all words in capital letters are constant code words for the MSI setup. Without /v, the following information is ignored and the standard information is used.</td>
</tr>
<tr>
<td>/L</td>
<td>The LOG file is switched on. The LOG file will be approximately 3.5 MB in size.</td>
</tr>
<tr>
<td>/QN+</td>
<td>A feedback message is displayed after the installation is completed.</td>
</tr>
</tbody>
</table>

An installation in Silent mode reboots the computer without a prompt if necessary. Ensure that all important applications are closed.

8.8 Carrying out a version change

8.8.1 Definitions

COMOS version

The COMOS version is maintained as a two-digit number.

Example: "COMOS 10.1"

- This may be followed by a third digit representing a release number.
- A code number for an update may also be included.

Example: "COMOS 10.1 Update 03"

To display the COMOS version, select "Help > COMOS Info" from the menu bar.

Database scheme

All object properties available in COMOS are stored in the database. When a new object property is introduced for a current COMOS version, the database must be expanded to include this new property.
COMOS index

The COMOS index is a function for boosting the performance of database adjustment. This tool carries out a number of tasks for the administrator concerning the administration of base data.

Database version

The database is assigned specific version numbers whenever relevant developments are made. The change of a database version has the result that older COMOS clients can no longer work with the database.

COMOS document version

Similar to the database model, there is a continuous development of options for documents. The document version regulates the range of options available for the user. New options can only be set when the document version has been increased.

8.8.2 Testing new version

8.8.2.1 Test

A test must include all activities and COMOS tools that are relevant for the production processes of the company.

8.8.2.2 Testing new version

The COMOS version and the database are interrelated in many ways. In particular, the display of documents or certain operating methods can change. Databases that are in productive use must not be converted unchecked under any circumstances.

8.8.2.3 Create a copy of the database

Make a copy of the database and test it with the current COMOS version.

Do this by creating a physical copy of the database plus document directory while retaining the RDBMS. On a server database that would be a dump which is loaded into a new database. In Access, a physical copy of the MDB file and the document directory are sufficient.

You have the option of exporting the data from a server database into an Access database, which can then be tested. Not only is this a quick way to make a copy of the server database, but the performance of the RDBMS is also improved if you use an Access database.

8.8.2.4 Installing a new COMOS client

You can operate different versions of COMOS simultaneously one one PC.
8.8 Carrying out a version change

8.8.2.5 Adjusting the COMOS index and the database scheme

If a current COMOS version offers new object properties, you need to adapt the database scheme. You cannot use the current COMOS version unless the database scheme has been adapted.

If a current COMOS version offers new database indices, you need to adapt the COMOS index. Once you have done this, you will be able to enjoy improved performance. Performance will not be improved unless you adapt the COMOS index.

The database scheme and COMOS index will be checked and adapted. If you open a current COMOS version with an older database with administrator rights, a dialog window appears.

- "No" button
  If you click the "No" button, the database remains unchanged and is not opened. COMOS remains open and you can select a suitable database.

- "Yes" button
  To adapt the database scheme and the indices, click the "Yes" button. Both the older and the new, current COMOS clients can continue to work as usual.
  No kind of data loss can occur. However, the older clients use the options that were made available only by updating the database model.

If you have administrator rights and open a current COMOS version with an older database, you are notified that the tables and indices need to be adapted.

After the message, COMOS remains open and you can select another suitable database.

8.8.2.6 Increasing the document version

The document version is managed in COMOS with the help of the Support dialog.

Once the document version has been increased, this cannot be fully undone. The documents saved or created after the increase cannot be reconverted.

8.8.2.7 Increasing the database version

The database version is managed in COMOS with the help of the Support dialog.

Once the database version has been increased, this cannot be undone.
8.8.3 Changing the version

Complete migration of all clients (recommended)

A complete migration involves the following steps:

- Log off all COMOS clients from the database.
- Install the new COMOS version on all clients.
- Adapt the database scheme and indices. then adapt the database. If necessary, adapt the document version and the database version.

Optional: Mixed installation

To perform a staggered migration / mixed installation, follow these steps:

- Install the new version on the individual computers.
- Log off all COMOS clients from the database.
- Adapt the database scheme and indices.
- The clients may log in again. New and old clients can work. However, some new functionalities are not yet available at this point, as neither the database version nor the document version have been incremented.
- Migrate all the remaining clients and adapt the databases.
- Once all clients have been migrated, adapt the document version and database version as needed.

8.9 Errors and special settings

8.9.1 Permissible screen resolutions

To adjust the screen display, follow these steps:

1. Right-click on the desktop.
2. Select the "Adapt" command.
3. Click on the bottom left of the list "See also" on "display".
4. Select one of the settings "Small", "Medium", "Large"

Note

User-defined font size

The "Determine user-defined font size (DPI)" is not permitted.
8.9.2 Interrupted communication

Communication between COMOS and the License Manager can be faulty for several reasons:

- Physical failure of a segment of the network
- Stopping or freezing of the License Manager
- Changes to the system configuration after installation etc.

This example deals with a situation where COMOS cannot address the license manager service (COMOS LS Service).

If communication between COMOS and the License Manager is disrupted, a corresponding message informing you of this is displayed in a dialog box. The software component COMOS LS cannot be executed correctly at this time. In this case, it is not possible to access a database.

If the network problem (either hardware or software end) is solved and the error message still appears, it may be necessary to execute the entire installation routine or parts of it again.

Contact the support in this case.

8.9.3 TIFF printer

Error: Sometimes the TIFF printer only creates "GRP" type files. This error should no longer occur with the new version of the TIFF printer driver.

Troubleshooting: This problem can only be solved by a new installation of the printer driver.

Proceed as follows:

1. Delete the printer entry from the printer directory.
2. Open the Setup browser.
3. Start the COMOS TIFF setup.
4. Remove the COMOS TIFF printer.
5. Restart the system and repeat the COMOS TIFF installation.

8.9.4 Resource problems while printing

Generally, you cannot increase the dpi number as desired when printing. At some time the system will reach its limits and can no longer carry out revisions correctly. This mainly depends on the amount of random access memory (RAM). Usually, the more RAM you have in the computer, the higher the maximum resolution for printing.

TIFF printing

The printer sends an error message if there is not enough RAM available for TIFF printing. The revision print is aborted with the warning: "Revision could not be printed". In the DebugView/DBMon the following error message is displayed:

[632] ++++++++++++++++++++++++++++++++++++++++++++++++++
[632] ComosDefRevPrn::ComosTiff::IRevisionPrinter_DoPrint():

pdfFactory does not report errors if resources are fading; instead, it prints until the resources are completely gone and then quits.

The result: incomplete printouts.

Fineprint, the manufacturer of pdfFactory, therefore recommends that the longer paper side should not exceed 32,767 pixels. This results in a maximum resolution of 600 dpi for DIN A0.
Discontinuations and functional boundaries

General distinctions for customer-specific customizing

**Interfaces and 3rd party components**

- The use of COMOS is only for approved interfaces and 3rd party components. This is also valid for the COMOS classes and COMOS libraries: Only classes and libraries expressly approved for use are permitted to be used for custom COMOS extensions, scripts or programs. You can find more information in the online help.

Discontinuations and functional boundaries 10.1.0

**P&ID - discontinuation of supported third-party software versions**

- Starting with version 10.2 the older versions of the following third-party software versions listed below are no longer supported:
  - PDF Import Adobe <8
  - XMpLant Import and Export <3.3.3
  - Conval Import and Conval Export <8
  - Autocad (DXF/DWG) Import <2007
  - Microstation (DGN) Import <7
  - PDS 2D Import <7

**FEED - discontinuation of supported third-party software versions**

- Starting with version 10.2 the EbsilonProfessional import is no longer supported.
  - In addition, starting with version 10.2 the older versions of the following third-party software are no longer supported:
    - AspenPlus Import <7.3
    - PRO/II Import <8.3
    - AspenHYSYS Import <7.3
    - UniSim Design Import <R400
    - ChemCad Import <6.1
    - ProMAX Import <3.2
    - HTRI Import and Export <6
    - AspenEDR Import and Export <7.3
License server

- The "SetLicPath.exe" file is no longer used.
  If you wish to use a different computer than before for the license server, you must set the
  new server name on each client using the "<COMOS installation path>\config
  \Comos.LicenseLib.config" tool.

Printer driver of the revision archive

- The following printer drivers are no longer available:
  - Adobe Distiller
  - Adobe PDF Writer
Known Issues

10.1 COMOS help system

Message "Navigation to the website was canceled"

If you open the COMOS help system from a network path, it cannot be displayed in the HTML viewer. The message "Navigation to the website was canceled" is then displayed.

To have the help system displayed correctly, copy the folder with the help texts locally to the machine.

Translations

The COMOS help system 10.1 is available in English and German.

The contents of the online help are not displayed

When you open an online help (CHM file) from a source in the network, only the table of contents of the online help is displayed in the left-hand section of the HTML Viewer. When you select a topic from the table of contents, no contents are displayed in the right-hand section.

This behavior is caused by the installation of 3 updates that were distributed by Microsoft:

- 896358 MS05-026: Vulnerability in HTML help could allow remote code execution
- 840315 MS04-023: Vulnerability in HTML help could allow code execution
- Windows Server 2003 Service Pack 1 (SP1)

You have two options for displaying the online help (CHM file) from a source in the network:

1. Enabling a specific path for the correct display of online help texts
2. Enabling a specific zone for the correct display of online help texts

Note

The system safety is reduced by the following adaptations. The adaptations should only be carried out after consultation with and approval by a system administrator. In case of doubt, contact the Microsoft customer support in order to reduce the safety risks.

Note

The following section describes how to edit the Windows Registry. Errors during editing can cause serious problems. Before carrying out editing, create a backup copy of the Windows Registry and inform yourself about how to restore the Windows Registry in case of problems.

Manual changes in the Windows Registry are carried out on your own responsibility.
A detailed description of the two solutions is available on the Internet in the Microsoft Knowledge Base in the article 896358 ([http://support.microsoft.com/kb/896358/EN-US](http://support.microsoft.com/kb/896358/EN-US)) the section "Approaches to working around application compatibility issues in security update 896358".

After adaptations, online help texts from the selected zone can be displayed correctly.

### 10.2 Incorrect installation under Windows 7 Enterprise and Server 2012

If you use Windows 7 Enterprise and Server 2012 / Windows 2012 R2, it may occur that COMOS does not install correctly during the first installation of an initial update.

In this case, the file paths will be empty. To install COMOS successfully, an installation in silent mode must be carried out after the incorrect installation has finished. Proceed as follows to do this:

1. Start the console in Windows by inputting CMD
   Administrator rights are required
2. Extract the Zip file that you will find on the COMOS DVD in the following path: `<\Software\Comos Main\Comos\Service Pack>`
3. If there is a "CURRENT" folder parallel to "BASE" and "Updatecenter", delete this "CURRENT" folder.
   Finish the update with the following call:
   "<COMOS installation folder>\updatecenter\Comos Update Center 4.exe" /Console /COMOSTYPE:101 /BASESETUP /PATH:"absolute path to unpacked servicepack"

### 10.3 COMOS License Management

**Expansion of statistics outputs by blocked licenses**

New event for the log file:

- **Release**
  Logging of licenses that are released again.
  If licenses are blocked by canceling COMOS, COMOS will release these licenses after three heartbeats. The license file is released on the license server and the release is also logged in the log file.

Storage of the log file:

- **File path:** `..\COMOS LS\Data\Logfiles\Statistics\Users\<Year>\<Month>`
- **Name of the log file:** `COMOSLSLicenseWorkload_<Year>_<_Month>.log`
Availability of the new event Release:

- As of COMOS LS 1.9.0
- COMOS LS 1.9.0 is delivered for the first time with the setup program COMOS 10.1 SP3.
- The release of COMOS LS for COMOS versions does not change. Check the installation instructions to determine the COMOS versions for which the COMOS LS software has been released.

10.4 Administration: PDF export with PDFlib

Version incompatibility of a third-party component

The PDFlib component requires the following Microsoft C++ Runtime 2003 libraries:

- msvcr71.dll
- mscvp1.dll

For legal reasons, these libraries are not supplied with the current COMOS version. PDFlib works when you copy the libraries to the "<Comos>BIN" folder.

In future COMOS versions, a new version of PDFlib will be used that no longer requires these libraries.

10.5 Administration: Subsequent changing of project properties in connection with consolidation layers

Subsequent changing of project properties in connection with consolidation layers

Consolidation layers are an optional method of checking imported data during database updates. For more information on this, refer to the "COMOS Platform Administration" manual, chapter "Check changes (consolidation)".

As long as a consolidation layer is created, the following applies:

- Do not change the entry in the "Base working layer" field (Properties of the project, category "General settings > Project data")

If the entry in the "Base working layer" field is changed, different types of malfunctions are possible in connection with the database update. Inconsistent data could result from a malfunction.

10.6 Administration: Adding documents to a task

Adding documents to a task

Delivery state for cDB for 10.1: Documents cannot be added to a task. If an attempt is made to add a document, COMOS can no longer be closed normally.
10.8 Administration: Copying the base project

Adaptation of absolute file name

If a base project is being copied using Copy&Paste, the following applies:

- Check whether hierarchically generated documents are correct.

Hierarchically generated documents are created, for example, when a row report is integrated in a report template or when headers and footers are generated using a subreport.

Background:

The path information in absolute file names is adapted during the copy operation. If some document parts (headers, footers) are displayed incorrectly in the copy of the base project, this is due to unadapted path information in the corresponding report template. To correct this, check the file name or the file name of the undisplayed document parts in your report template.

10.7 Administration: Service for full-text search

Service for full-text search

The "Index update on server" functionality from the project options under the "Full-text index" tab has not been released for delivery.
10.9 Administration: Attributes with fixed format length

If a fixed input length is defined for an attribute in the "Format" field, then the mask is not evaluated in object queries for this attribute.

Example: The entry "???.999" is in the "Format" field.

The attribute can be edited as usual in the properties of an object. Three letters followed by three alphanumeric characters are allowed according to the example above.

10.10 Administration: Merging objects in the cDB

New standard for "Merge"

The new standard for the "Merge" technology specifies that you are required to work with the "MergeMode" tab for assemblies that are copied in.

When assemblies are copied in, the Merge method is called automatically. All new objects are evaluated to determine whether they have the "MergeMode" tab and, if so, whether the "MergeOnTemplateCreate" attribute has been assigned the value "1".

- If so, a search is conducted for the partner that is to be merged with the new object. With subobjects, the search is first carried out through the MatchKey. If this is not successful, a search is carried out for an object with an identical name. If a partner for merging is found, the Merge method is called at the existing object. The new, copied-in object is handed over as slave and the value 256 is used for the mergeMode parameter. To introduce a different behavior, specify it in the "MergeMode" tabs of the assembly.

- When the "MergeMode" tab does not exist, the attributes are not merged but copied. This may result in duplicate tabs.

The following applies to recursive merging: If there are further child objects below an object, these are also merged.

This standard works just as it does in the iDB. You can find more information on this topic in the "Platform Administration" manual, keywords "Merging objects" and Automatic merging for assemblies".
To change the standard described above, proceed as follows:

- Change the project properties "MergeModeChapterMandatory"
  This project property is not visible in the cDB. Change the project properties using the object debugger:
  ```csharp
  Set mergeOpt = a.Project.OwnParameters.CreateNewWithName("MergeModeChapterMandatory")
  mergeOpt.value = "0"
  When the project is opened again, the changed project property will become effective.
  ```
  - mergeOpt.value = "0"
    Deactivated
    Recursive merging is deactivated by default. The "MergeMode" tab can be used to include individual objects during recursive merging.
  - mergeOpt.value = "1"
    Activated
    Recursive merging is used by default. The "MergeMode" tab can be used to exclude individual objects from recursive merging.

10.11 Administration: Performance with SBM

A performance problem of SBM (NewCVS) can be remedied with the following script.

Proceed as follows:

1. The database name in the first row must be changed in the script.
2. The script has to be executed by the administrator in the third-party software "Microsoft SQL Server".

Example

```sql
USE [database_name]
GO
BEGIN TRANSACTION

-- drop procedure which uses the data type
DROP PROCEDURE [dbo].[sp_publish_content]
GO

-- drop data type itself
DROP TYPE [dbo].[ud_Uids]
GO

-- recreate data type with new length
CREATE TYPE [dbo].[ud_Uids] AS TABLE(  
  [Uid] [nvarchar](max) NULL
)
GO

-- recreate stored procedure which uses the type
SET ANSI_NULLS ON
```

Known Issues

10.11 Administration: Performance with SBM

COMOS 10.1.3.0.0 - Readme
Readme, 04/2015, A5E32016431-AF
GO

SET QUOTED_IDENTIFIER ON
GO

CREATE procedure [dbo].[sp_publish_content]
    @uidsList AS ud_Uids readonly,
    @QueueName AS nvarchar (100) = NULL
as
BEGIN
    DECLARE @dh uniqueidentifier;
    DECLARE @dbg nvarchar (100), @uid nvarchar (max);
    DECLARE @QueueNameFounded AS NVARCHAR(MAX) = NULL;
    SET @dbg = N'sp_publish_content';
    SET @dh = null;
    BEGIN try
        declare crs cursor static read_only forward_only for
            SELECT subscr.conversation_handle as dh,
                UidsList.Uid as uid
            FROM @uidsList UidsList, subscriptions subscr
            WHERE subscr.conversation_name != @QueueName
        open crs;
        fetch next from crs into @dh, @uid;
        while @@fetch_status = 0
            begin
                if exists (select conversation_handle from
                    sys.conversation_endpoints where state <> 'ER' and
                    conversation_handle = @dh)
                    Begin
                        EXECUTE ('SEND ON CONVERSATION (''' + @dh
                            + ''') MESSAGE TYPE [subscription_content] (''' + @uid
                            + ''');');
                    end
                else
                    Begin
                        disable trigger AfterDeleteConversation on
                        subscriptions;
                        delete from subscriptions where
                        conversation_handle = @dh;
                        enable trigger AfterDeleteConversation on
                        subscriptions;
                    end
                close crs;
                deallocate crs;
            end
        end try
        BEGIN catch
            -- Execute the error retrieval routine.
            EXECUTE dbo.sp_FillErrorTable;
        end catch
    end try
    begin catch
        -- Execute the error retrieval routine.
        EXECUTE dbo.sp_FillErrorTable;
    end catch


10.12 ElementName Z

Inheritance of object to parent device

Note
Do not use Z as object name.

When an object with the name Z is created below a device, the installation/3D data are applied to the device.
This is also the case when the object name is changed to Z.

Example: A varistor is created below an auxiliary contactor. It is renamed to Z. Different assembly data is entered for the varistor. This data is now also applied to the auxiliary contactor.

Functionality is tied to this naming process.

10.13 Troubleshooting during excessive GDI resource consumption with COMOS

Problem description
COMOS may consume excessive GDI resources when you use Windows 7 SP1 or Windows Server 2008 with Citrix. Under certain conditions this can result in the user interface or its elements not being displayed correctly in COMOS. This affects mainly queries and evaluating reports.

In Task Manager you see that the number of GDI objects has reached or exceeded 10,000.

Troubleshooting
Microsoft provides the hotfix KB2719248. Install this hotfix if your GDI resource consumption by COMOS is too high.

See also
GDI Resources (Page 77)
10.14 Interfaces: PDI interface

Core statement

We are aware of a malfunction in the Process Data Interface (PDI) in interaction with older versions of the Microsoft .Net Framework 4.0. The malfunction occurs during the synchronization of resources and units between COMOS and Teamcenter. The operation started by the user is aborted without an error message. The corresponding window remains open and empty.

To resolve this problem, install the patch KB2858725 offered by Microsoft. You can find this under the following link:


10.15 Incompatibilities when changing from "PDMS PipeSpec Interface" to "COMOS PipeSpec Interface (PDMS)"

Incompatibilities when changing from "PDMS PipeSpec Interface" to "COMOS PipeSpec Interface (PDMS)"

Note the following when changing from the "PDMS PipeSpec Interface" product to the "COMOS PipeSpec Interface (PDMS)" product as part of the pipe spec export:

Changes to the software architecture of the "COMOS PipeSpec Interface (PDMS)" product may result in incompatibilities after a change if you have made special customizations which are based on the files for the data exchange.

10.16 Interfaces: CDI

CDI exclusions

CDI cannot process DVM documents.

- CDI and DVM save changes at different times.
- CDI and DVM use a different hierarchy when accessing documents.

10.17 Interfaces to MS Project and Primavera

The interface from COMOS to MS Project and Primavera is not included in version 10.1.3.
10.18 **Report templates dependent on working layers**
The "Report templates depending on working layers" function is available if an iDB type database is used.

You can find more information on this topic in the "COMOS Platform Administration" manual, keyword "Creating a working layer-dependent template file in COMOS".

When a cDB is used, the full range of functions is not available.

10.19 **"Revision" file name prohibited**
The file name "Revision" is not allowed for pictures that are loaded on reports as follows:

- Report designer > Place picture box
- Move the image file (JPG, BMP) from the Navigator or Windows Explorer onto the report using drag-and-drop.

**Background:**
The "Revision" file name for integrated pictures is reserved exclusively for redlining documents.

10.20 **Add-ins are not displayed**

**Microsoft Office applications**

No add-ins for Microsoft Office applications (Word, Excel, PowerPoint and Outlook) are displayed when you are using COMOS with Windows 7. This function will be available once again with a future version of COMOS.

10.21 **Report: Insert OLE object**

Documents can be inserted as OLE objects in a report template and an interactive report. The following exceptions apply:

- **DVM functions are not supported:**
  - No DVM documents can be created as OLE objects.
  - OLE objects cannot be transferred to DVM documents (no checkout/checkin possible).

- **If the OLE object is opened on the report, the associated document is assigned the document type "General document":**
  - Only the properties of the "General Document" document type are available.
  - CDI is not supported.

- **When an OLE object is used and processed in different working layers, changes to the OLE object are transferred to other working layers with a delay.**

- **The display of OLE objects is controlled by the operating system and is thus varies theoretically depending on the client.**
10.22 P&ID: Project properties for pipe spec mapping

Modified project properties

Base project “SO1”: The following project properties are supplied for a new database with the modified default:

- "Process engineering > PipeSpec Manager" category
  - "Pipe spec"
    Old: Y00T00003.Y00A00052
    New: Y00T00135.Y00A00052
  - "Nominal diameter for the first connector (input)"
    Old: Y00T00003.Y00A00744
    New: Y00T00135.Y00A00744
  - "Nominal diameter for other connector (output)"
    Old: Y00T00003.Y00A00744AA02
    New: Y00T00135.Y00A00744AA02

These project properties control the following function, among others: "Execute pipe spec mapping via the Navigator". You must enter new values in the project properties to execute the work step "Plugins > Basic > Pipe spec mapping" in the COMOS menu. The "Pipe spec mapping" tab will remain blank as long as the old project properties are entered.

<table>
<thead>
<tr>
<th>NOTICE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Database update does not register these new default values</td>
</tr>
<tr>
<td>When you execute a database update, the properties described above are not modified. If necessary, you have to adjust the properties to the new default manually.</td>
</tr>
</tbody>
</table>

10.23 Inspection: Calibration of measuring devices

Not included in the product package

The calibration of measuring devices is not included in version 10.1.3.

10.24 Shutdown

Plates

Plates are not supported.
10.25 MRO: System-relevant tab

Display of a system-relevant tab

The "@40 > A20 > Y00 > A10 > A10 > Y00T00009 > A05 Dynamic attributes (MRO)" tab is displayed in the MRO environment. The tab is only relevant to the system. Users cannot perform editing in this tab.

10.26 Word export

Export reports to Word

Exporting reports to Word is designed only for one or a maximum of two pages. This function is not enabled for larger reports and pages numbering more than two in Word.

10.27 Integrated Engineering

Reengineering of control modules including functions or standard functions

When you import a new control module that includes two functions or standard functions of the same type from PCS 7 and would then like to reengineer it, start by first importing and reengineering the control module and then the functions or standard functions.

"Assembly Updater" plugin

When you update instances with the "Assembly Updater" plugin, the instances receive a new system ID. For renamed objects to be recognized again during data exchange, synchronize the ID with PCS 7.

Closing references

When references are closed, the project name is not considered. If you use identical hierarchy levels in two projects and wish to close a reference across projects, the reference may not be closed correctly in certain circumstances.
Changes following deadline

11.1 Introduction

In this chapter, deviations from the supplied user documentation are listed.

11.2 COMOS Platform

11.2.1 Platform Administration

COMOS LS

Section "Reference for ComosLS.exe.config":
- Enumeration <StatisticWorkloadGenerate>
  - Old: ":- Action (CHECKOUT, CHECKIN)"
  - New: ":- Action (CHECKOUT, CHECKIN, RELEASE)"

Attribute search

"COMOS Platform Administration" manual, "Attribute search" topic:
If a search is made for two strings, the strings are linked with "OR". It is not possible to select another operator in the "Logical OP" field.

11.3 COMOS Automation

Product data: supported device classes
- New: Class "Function"
As such, the following classes are now supported:
- Class "Device"
- Class "Element"
- Class "Accessories"
- Class "Position"
- Class "Location"
- Class "Function"
11.3.1 EI&C

Assembling the mounting plate

Only use the front view of the control cabinet circuit to assemble the mounting plate.

Engineering tasks

"EI&C Administration" manual, section "Preparing engineering tasks".

- The field names in the "System" tab have been changed. The old field names are documented in the manual. The content of the options are unchanged.

- The list of tasks was expanded with the entries "Create hierarchical assemblies" and "Page generator". These two entries are not yet documented.

11.3.2 Integrated engineering

Using the cDB

If you use COMOS 10.1.1.0.0 with the cDB, adjust the script for the attribute "station name" at the following base objects:

@10 > AES > 2 > AES020 > 02 > 01 > AES020 > AES0011 and @10 > AES > 2 > AES020 > 06 > AES020 > AES0011

The script has to read out the station name and not the description of the station as before. If you do not make this change, an error results when transferring from control modules.

11.3.3 Engineering tasks

Copying positions

When you copy a position for which the "Assigned station" task is executed on its "Tasks > SW interface" tab, the target object of the task is not displayed in the properties of the copy. Nevertheless, the task counts as already executed. For this reason, enable the option "Undo task at copy" in the "General" control group of the "System data" tab in the properties of the task before copying. Then set the lost target object again. You can find additional information on this topic in the "EI&C Administration" manual, keyword "Reference of the "System data" tab".
11.4 COMOS Process

11.4.1 Configuring and displaying the piping bar

You can work with piping bar on P&IDs. This bar reads and displays the value of selected attributes of pipes or pipe sections that are placed on the report.

You can have the bar displayed on P&IDs.

The administrator specifies which data is included in the bar at the base object of the pipes or pipe sections.

Example for a piping bar:

<table>
<thead>
<tr>
<th>Label</th>
<th>Nominal diameter</th>
<th>Nominal pressure</th>
<th>Pipe spec</th>
<th>Medium</th>
<th>Volume flow</th>
<th>Operating temperature</th>
<th>Operating pressure</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>DN 25</td>
<td>PN 2.5</td>
<td></td>
<td>None</td>
<td>m³/h</td>
<td>°C</td>
<td>bar</td>
</tr>
</tbody>
</table>

Displaying a piping bar

1. In the engineering data, open the properties of the P&ID on which you wish to display the bars.
2. Select the "Attributes > Pipe bar" tab.
3. Select the option "Display piping list" in the opened tab.
4. Confirm your entries.
   The selected bars will be displayed the next time you open the P&ID.

Editing basic data of the piping bar

Define the object type on the P&ID from where values should be read and the row titles of the table rows.

1. In the engineering data, open the properties of the P&ID on which you wish to display the bars.
2. Select the "Attributes > Pipe bar" tab.
3. In the "Display options" list, select whether the displayed values of pipes or pipe sections are to be read.
4. Enter a name for the row titles for fields "Field 1" to "Field 7".
   Each entry is displayed in bold type in the first column of the bar.
5. Confirm your entries.
6. To have the names shown in an open P&ID, click the "Reevaluate document" button in the toolbar of the P&ID.

**Editing the contents of piping bar**

1. Open the base object properties for pipes or pipe sections.
2. Select the "Attributes > Pipe bar" tab.
3. Use drag-and-drop to enter the attributes in fields "Field 1" to "Field 7" under the label "Link attribute for display". These fields read the value of the attribute and display it in the appropriate row of the bar.
4. In the "Representation type" lists, select the representation of the attribute value.
5. Confirm your entries.
6. To have the values shown in an open P&ID, click the "Reevaluate document" button in the toolbar of the P&ID.

**11.4.2 Configuring and displaying the equipment bar**

You can work with an equipment bar on P&IDs. This bar reads and displays the value of selected attributes of equipment that is placed on the report.

You can have the equipment bar displayed on the following reports.

- P&IDs
- PFDs

The administrator specifies which data is included in the bar at the base object of the equipment.

**Displaying an equipment bar**

1. In the engineering data, open the properties of the report on which you wish to display the bars.
2. Select the "Attributes > Equipment list" tab.
3. Select the option "Display equipment bar" in the opened tab.
4. Confirm your entries. The selected bars will be displayed the next time you open the P&ID.

**Editing basic data of the equipment bar**

On the report, you define the row titles of the table rows.

1. In the engineering data, open the properties of the report on which you wish to display the bars.
2. Select the "Attributes > Equipment bar" tab.
3. Enter a name for the row titles for fields "Field 1" to "Field 7". Each entry is displayed in bold type in the first column of the bar.

4. Confirm your entries.

5. To have the names shown in an open report, click the "Reevaluate document" button in the toolbar of the P&ID.

**Editing content of the equipment bar**

1. Open the properties of the base object of equipment.
2. Select the "Attributes > Equipment bar" tab.
3. Use drag-and-drop to enter the attributes in fields "Field 1" to "Field 7" under the label "Link attribute for display". These fields read the value of the attribute and display it in the appropriate row of the bar.
4. In the "Representation type" lists, select the representation of the attribute value.
5. Confirm your entries.
6. To have the values shown in an open report, click the "Reevaluate document" button in the toolbar of the P&ID.

**11.4.3 Configuring and displaying the pipe list**

The pipe list is an evaluation report. Depending on the object below which you create the list, all pipes are recursively detected and displayed in the list.

The pipe list reads and displays, among other things, the value of the attributes of the following control groups at pipes:
- Pipe properties, "General information" tab, "General information 2" control group
- Pipe properties, "Pipe list" tab, "Piping bar data" control group
- Pipe properties, "Pipe list" tab, "Piping list data" control group

**Configuring the pipe list**

1. Open the base object properties for pipes.
2. Select the "Attributes > Pipe list" tab.
3. Use drag-and-drop to enter the attributes in fields "Field 1" to "Field 20" under the label "Link attribute for display". These fields read the value of the attribute and display it in the list.
4. In the "Representation type" lists, select the representation of the attribute value.
5. Confirm your entries.
6. To have the values shown in an open report, click the "Reevaluate document" button in the toolbar of the P&ID.
Creating a pipe list

1. Select one of the following objects in the Navigator:
   - Plant
   - Unit
   - Subunit

2. In the context menu, select the "New > PB.004 Pipe list" command. The list is created and filled.

11.4.4 Configuring and displaying the equipment list

The equipment list is an evaluation report. Depending on the object below which you create the list, all P&ID objects or FEED objects are recursively detected and displayed as equipment in the list. These objects are characterized by the fact that you can create them with the "New" command in the context menu of the "Equipment" folder.

The equipment list reads and displays, among other things, the value of the attributes of the following control groups at equipment:

- Equipment properties, "General information" tab, "General information 2" control group
- Equipment properties, "Equipment list" tab, "Properties for device bar" control group
- Equipment properties, "Equipment list" tab, "Equipment list data" control group

Configuring an equipment list

1. Open the properties of the base object of equipment.
2. Select the "Attributes > Equipment bar" tab.
3. Use drag-and-drop to enter the attributes in fields "Field 1" to "Field 20" under the label "Link attribute for display". These fields read the value of the attribute and display it in the list.
4. In the "Representation type" lists, select the representation of the attribute value.
5. Confirm your entries.
6. To have the values shown in an open report, click the "Reevaluate document" button in the toolbar of the P&ID.
Creating an equipment list

1. Select one of the following objects in the Navigator:
   - Plant
   - Unit
   - Subunit
   - Process
   - Process unit

2. In the context menu, select the "New > PB.001 Equipment list" command or "New > Equipment list".
   The list is created and filled.

11.4.5 Using additional lists

You can create the following additional lists under a plant, a unit or a subunit:

- "PB.002 Machine list"
- "PB.003 Control valve list"
- "PB.005 Special equipment list"
- "PB.006 Conveyance means list"

Procedure

Select "New> <List>" command from the context menu of the given object.

See also chapter Configuring and displaying the pipe list (Page 129).

11.5 COMOS Lifecycle

11.5.1 COMOS PDMS integration

COMOS PDMS Engineering Interface based on AVEVA E3D available

- The COMOS PDMS Engineering Interface was renamed to "COMOS PDMS/E3D Engineering Interface".
- You can also use the COMOS PDMS/E3D Engineering Interface based on the AVEVA Everything 3D software platform.
Operating COMOS PDMS Engineering Interface with Citrix XenApp versions up to and including 7.6

You can operate the COMOS PDMS Engineering Interface in network mode with Citrix XenApp versions up to and including 7.6.

**Note**

In file mode up to and including Citrix XenApp 4.5

In file mode, you can operate the COMOS PDMS Engineering Interface with Citrix XenApp versions up to and including 4.5.

**Note**

COMOS PDMS Interface up to and including Citrix XenApp 4.5

You can operate the COMOS PDMS Interface with Citrix XenApp versions up to and including 4.5.

**Topic "Automatically adding additional hierarchy levels"**

The function described in the manual will only become active when the top object of the three-level structure in the PDMS Engineering Interface is located below a ZONE.

You can find additional information on this topic in the "3D Integration Administration" manual, keyword "Automatically adding additional hierarchy levels".

**Topic "Requesting objects"**

You do not request objects in the PDMS/E3D Engineering Interface using the context menu, but with the "Request data" button in the toolbar of the plugin.

You can find additional information on this topic in the "3D Integration Operation" manual, keyword "Requesting objects".

**Topic "Assign by reference number"**

When you select the command "Assign by reference number" in the PDMS/E3D Engineering Interface, all COMOS objects underneath are recursively assigned to the PDMS objects below the corresponding PDMS object by reference number.

You can find additional information on this topic in the "3D Integration Operation" manual, keyword "Assigning COMOS objects and PDMS objects".

**Topic "Inconsistencies"**

- When you remove inconsistencies that require adjustments at the PDMS end, the PDMS data are synchronized with data already loaded in the scope and updated.
- When you remove inconsistencies that require adjustments at the PDMS end, these are taken from the PDMS object and written to the corresponding COMOS object.

You can find additional information on this topic in the "3D Integration Operation" manual, keyword "Removing inconsistencies".
11.6 COMOS Operations

11.6.1 Sending e-mails via Maintenance Demon

Enterprise Server

Sending e-mails via Maintenance Demon in connection with the Enterprise Server is only possible via SMTP.

11.6.2 "Incidentals" option

"Direct" plugin

Incidentals and the corresponding "Incidentals" option are not currently supported.
Changes following deadline

11.6 COMOS Operations